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Chapter 1

Creating and Packaging Custom IP

Introduction
Using the Vivado® IP packager flow gives you a consistent experience whether using 
Xilinx® IP, third-party IP, or customer-developed IP.

IMPORTANT: Some Xilinx IP requires licensing. After purchasing the required license, you can include 
Xilinx IP in your design. 

Figure 1-1 shows the flow in the IP packager and its usage model. With the Vivado IP 
packager an IP developer can do the following:

° Create and package files and associated data in an IP-XACT standard format. 

° Add IP to the Vivado IP catalog. 

° Deliver packaged IP to an end-user in a repository directory or in an archive (.zip) 
file. 

After you distribute IP, an end-user can create a customization of that IP in their designs.

Before packaging your RTL as an IP, it is recommended you do the following:

° Verify the design sources by running synthesis (see Vivado Design Suite User Guide: 
Synthesis (UG901) [Ref 22]) and implementation (see Vivado Design Suite User 
Guide: Implementation (UG904) [Ref 25]). 

° Verify the design simulates as expected (see Vivado Design Suite User Guide: Logic 
Simulation (UG900) [Ref 6].)

° If using Xilinx parameterized macros (XPMs), see Using XPMs in Chapter 3. 
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Chapter 1: Creating and Packaging Custom IP
X-Ref Target - Figure 1-1

Figure 1-1: IP Packaging and Usage Flow 
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Chapter 1: Creating and Packaging Custom IP
Supported IP Packager Inputs
The Vivado IP packager supports the following input file groups:

• HDL synthesis

• HDL simulation

• Documentation

• HDL test bench

• Example design

• Implementation files (including constraint and structural netlist files)

• Drivers

• GUI customization

• Block Design (BD) files from Vivado IP integrator

TIP: You can encrypt source files, or modules and architectures defined within the source files to protect 
the IP. See Chapter 6, Encrypting IP in Vivado for more information.

IP packager can designate as many or as few file groups as is appropriate to the IP. There is 
no requirement for a minimum set of file groups; however, the IP packager IP File Groups 
page presents a typical set of file groups, based upon the packaged project sources. When 
any of these file groups are empty, the final Review and Package page issues a warning 
about missing file. 

IMPORTANT: The Vivado IP packager does not support IP in the Core Container format. Disable the 
Core Container feature for all IP prior to packaging. For more information on Core Container, see this 
link in the Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 8].
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Chapter 1: Creating and Packaging Custom IP
Outputs from IP Packager
The IP packager generates the following outputs:

° An XML file based on the IP-XACT standard, component.xml.The 
component.xml is located in the IP root directory, and identifies the IP definition 
information. The associated files of the custom IP are relative to the IP-XACT XML 
file.

° An XGUI customization Tcl file. The XGUI customization Tcl file is located in the 
<IP root directory>/XGUI, and contains the customization GUI of the custom 
IP from the IP catalog.

° Files that are categorized in directories based on usage (for examples, see: /src, 
/sim, /doc).

° Any IP catalog directories that you create to contain the packaged IP.

See Table 3-1, Directory Inference Recommendation in Chapter 3 for a list of directories 
that are typically packaged.

If you package the project remotely, the IP packager copies the associated IP files to the 
selected IP location.

CAUTION! The IP packager output files are not meant for manual edits

Using the Packager Settings
The following steps are to set Packager default behavior in a project. To set the Packager 
options, from Tools > Settings. Select IP from Project Settings, and click the Packager 
option under IP, shown in Figure 1-2.
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X-Ref Target - Figure 1-2

Figure 1-2: IP Project Setting: Packager 
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Chapter 1: Creating and Packaging Custom IP
Set the following options:

° In Default Values:

- Vendor: Sets the vendor name when packaging a new IP. This is, for example, 
the top domain name of a company. 

- Library: Sets the associated library for the IP. This category, along with the 
Vendor are used in conjunction with the IP name to create a unique identifier. 

- Category: Specifies the categories in the IP catalog in which to place the IP. For 
example, /UserIP. 

Note: If necessary, you can change the default values during the IP packaging process. 

- IP Location: Specifies the location to use for your packaged IP. 

In Automatic Behavior, check or uncheck the options you want:

° After Packaging:

- Create archive of IP: After packaging an IP, automatically creates an archive (ZIP 
format) of the IP. For information on how to set the location of a ZIP file, see 
Creating an Archive of the IP. 

- Add IP to the IP Catalog of the current project: Adds the current IP to the IP 
catalog.

- Close IP Packager window: Closes the Package IP window automatically when 
IP packaging is complete.

In the Edit IP in IP Packager, check or uncheck the Delete project after packaging 
checkbox to remove the iterative editing project after the IP is re-packaged.

In File Extensions to Filter on Add Directory: Add extensions (for example, TXT) to 
automatically filter when selecting a directory to include in a File Group when packaging 
an IP. 

For more information about IP settings, see the Vivado Design Suite User Guide: Designing 
with IP (UG896) [Ref 8].
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Chapter 2

IP Packaging Basics

Introduction
This chapter describes some of the basic use cases of creating and packaging custom IP. 
Some of the topics include HDL requirements, versioning, editing an existing custom IP, and 
using expressions

It is recommended that certain actions are taken to ensure a smooth and flexible experience 
when creating your custom IP. These recommendations are for working within the 
framework of the Vivado IDE.

IMPORTANT: Some Xilinx IP requires licensing. After purchasing the required license, you can include 
Xilinx IP in your design. 

Top-Level HDL Requirements
The IP packager supports HDL synthesis language constructs for the top-level HDL file of 
the IP. Following these requirements ensures proper functionality of your custom IP. 

• The IP packager supports Verilog and VHDL as a top-level.

IMPORTANT: If you have a SystemVerilog top-level design file, create a Verilog wrapper file prior to 
packaging. 

• The supported SystemVerilog constructs are the same as those supported in Xilinx 
synthesis. See this link for a list of supported SystemVerilog constructs. 

• The IP packager does not support VHDL-2008. 

• All IP used within the Vivado IP catalog support multi-language usage, which allows 
the end user to generate an HDL wrapper for a language different than your IP. 

• To avoid conflicts, avoid using HDL language keywords within the design.

• To ensure that the custom IP simulates properly when using VHDL, set the top-level 
ports to be std_logic or std_logic_vector. 
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Chapter 2: IP Packaging Basics
Regardless of the top-level port type, when you synthesize the IP out-of-context (OOC), the 
resulting IP netlist ports are converted to std_logic or std_logic_vector. The 
converted netlist ports could cause type mismatch issues with RTL simulation.

For Verilog, module declarations with complex or split ports are not supported. 

RECOMMENDED: Modify the module declaration to remove these port types, or create a wrapper file 
around the module to contain only the supported port types for packaging your design.

As an example, the following module declaration contains both complex and split port 
types:

module top({in1, in2}, out[0], out[1]);
input        in1, in2;
output [1:0] out;

endmodule

Custom Functions in HDL
The Vivado IP packager requires that the IP ports are contained within the port description 
of the XDC file; therefore, the IP packager does not support custom functions defined in 
your HDL. 

RECOMMENDED: The recommendation for ports that require a custom function is to change your 
algorithm into a supported mathematical expression in either the HDL or the IP packager.

The Vivado IP packager supports standard arithmetic and logical operators to create the 
desired mathematical expression. To support complex mathematical expressions, the IP 
packager supports XPATH functions. The following table lists the supported XPATH 
functions. 

Table 2-1: Supported XPATH Functions

XPATH Function

number max(node-set)

number min(node-set)

number sum(node-set)

number log(base number, number)

number pow(number, exp number)

number floor(number) 

number ceiling(number)

number round(number)

number abs(number)

boolean not(boolean)
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Chapter 2: IP Packaging Basics
For more information on XPATH and the supported functions, see the W3Cx website. 

For example, the following Verilog code declares an output port whose width is defined 
from a ceil_log2 function call on the max_count parameter. The function calculates the 
log base 2 of the input and returns the smallest integer that is not less than the log result.

output [ceil_log2(max_count)-1:0] count;

To convert this function into an expression that the IP packager can use, replace the custom 
function with XPATH functions. This change does not occur in the HDL because the custom 
function is still used, but the IP packager uses a different mechanism for calculating the 
correct value. The following XPATH expression produces the same result as the custom 
function as described.

ceiling(log(2, $max_count))-1

The expression contains the XPATH log() function which is passed the base 2, and the 
value of the max_count parameter. The output of the log() function is passed to the 
ceiling() function to return the smallest integer not less than the log result. Finally, one 
is subtracted from the final ceiling result.

For more information on setting the XPATH functions on ports in your custom IP, see the 
Ports and Interfaces section.

Inferring Signals
This section describes inferring clock and reset interfaces, and gives a brief description of 
AXI signals.

Inferring Clock and Reset Interfaces
The Vivado IP packager can automatically infer interfaces for clock and reset signals for 
your IP. This helps the use of custom IP in the IP integrator for validating clock and reset 
signals within the block diagram. There is a required nomenclature to properly infer clock 
and reset interfaces. If the reset signal does not contain the required nomenclature, you can 
manually create the interface and the set the properties accordingly.

boolean true()

boolean false()

Table 2-1: Supported XPATH Functions (Cont’d)

XPATH Function
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Chapter 2: IP Packaging Basics
IMPORTANT: The IP Packager checks for the ASSOCIATED_BUSIF parameter for all clock interfaces. 
The reason for the warning is that the IP integrator tool works best with interfaces, and it was expected 
that user would typically be using AXI interfaces. If you do not have any bus interfaces in your design, 
you can safely ignore this warning. For more information on parameters related to clock interfaces, see 
this link in the Vivado Design Suite User Guide: Designing IP Subsystems Using IP Integrator (UG994) 
[Ref 17].

The following table describes how the reset is inferred based upon the naming of the signal. 

Note: The [*_] and [_*] are optional and the * matches any text. 

For reset signals that end with n such as resetn and aresetn which implies an active-Low 
signal, the interface automatically sets the POLARITY parameter to active_Low. This 
parameter is used in the Vivado IP integrator to determine if the reset is properly connected 
when the block diagram is generated. For all other reset interfaces, the POLARITY 
parameter is not set, and is determined through the parameter propagation feature of IP 
integrator. For more information on parameter propagation and IP integrator, see this link 
in the Vivado Design Suite User Guide: Designing IP Subsystems Using IP Integrator 
(UG994)[Ref 17].

Inferring Clock Interfaces
To properly infer a clock interface, the clock signal needs to have a required nomenclature 
as well. The following table describes how the clock signals are named. 

If the clock signal does not contain the required nomenclature, the interface can be 
manually created and the properties set accordingly. 

Table 2-2: Reset Signal Naming 

[*_]reset[_*] 

[*_]resetin 

[*_]resetn 

[*_]rst 

[*_]rstin 

[*_]aresetn 

Table 2-3: Clock Signal Naming

[*_]clk

[*_]clkin

[*_]clock[_*]

[*_]aclk

[*_]aclkin
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Chapter 2: IP Packaging Basics
Inferring Differential Clock Interfaces
To properly infer a differential clock interface, each pin of the differential pair requires the 
same nomenclature, as shown in the following table.

Inferring AXI Signals
Xilinx has adopted the Advanced eXtensible Interface (AXI) protocol for its Intellectual 
Property (IP) cores, the use of the protocol in your custom IP gives the flexibility to connect 
with other IP in the Vivado IP catalog. If the port signals of your custom IP adhere to the AXI 
naming conventions, the Vivado IP packager automatically infers the AXI interface. 

The proper nomenclature to infer the AXI interface is to ensure that the port name consists 
of an interface name followed by the AXI signal name. Any name can be used for the 
interface as long as the name is consistent for each port. The following table is an example 
naming convention for inferring an AXI4-Stream interface with interface name s0_axis.

For more information regarding the AXI interface, see the Vivado Design Suite AXI Reference 
Guide (UG1037) [Ref 18].

Table 2-4: Differential Clock Interface Naming

[*_]clk_p

[*_]clk_n

Table 2-5: Port Naming for AXI4-Stream Interface Nomenclature

s0_axis_tdata

s0_axis_tvalid

s0_axis_tready

s0_axis_tstrb

s0_axis_tkeep

s0_axis_tlast

s0_axis_tid

s0_axis_tdest

s0_axis_tuser
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Chapter 2: IP Packaging Basics
Packaging a Design with Global Include Files
The Vivado IDE supports designating Verilog or Verilog Header files as global `include 
files to process before any other sources. 

Note: This feature is not supported when packaging a custom IP. 

After packaging, the Vivado tool treats global ̀ include files as standard Verilog or Verilog 
Header files.

To package a design that uses global ‘include files, you must modify the HDL to place the 
`include statement at the top of any Verilog source file that references content from 
another Verilog or Verilog header file.

Constraints Requirements
The IP packager supports the including constraints files (XDC) along with RTL files. The 
following are the supported XDC file types:

• XDC to be used during synthesis and implementation (default)

• XDC to be used only during implementation

• XDC for use only during out-of-context (OOC) synthesis

This section describes the following concepts:

• Managing Out-of-Context Constraints

• Processing Order of Constraints

For more details on IP constraints, see Vivado Design Suite User Guide: Using Constraints 
(UG903) [Ref 5], and for constraints in general see Vivado Design Suite User Guide: Synthesis 
(UG901) [Ref 22].
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Chapter 2: IP Packaging Basics
Managing Out-of-Context Constraints
By default, IP are synthesized out-of-context (OOC) of the top-level design. When you use 
the out-of-context flow, an OOC flow-only XDC is required for sequential logic timing 
during Vivado synthesis. This XDC file provides clock definitions for clocks from the 
top-level, either from the user or from another IP. 

When creating your custom IP, it is recommended that you include an OOC XDC file to 
provide these clock definitions for synthesizing the IP standalone. 

For more information on the OOC flow, see the following documents:

° Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 8]

° Vivado Design Suite User Guide: Synthesis (UG901) [Ref 22]

Note: For Xilinx delivered IP, the OOC XDC file has _ooc appended to the filename. This is not a 
requirement, because the USED_IN file property determines if it is an OOC XDC file, not the 
filename.

In a typical design, an IP receives some of its required constraints from the top-level design. 
For example, if your custom IP does not directly interface with the device boundary, it 
typically relies on the parent design to supply the input clock definitions. The OOC XDC file 
generally only contains these input clock definitions. This is required so that clock 
definitions exist when the IP is synthesized OOC of the top-level constraints. While this is 
not a requirement, it is not recommended to add any additional constraint types. During 
implementation of the entire design, the IP netlists link with the top-level netlist and the 
OOC XDC is not required.

There are two instances in which an IP must have the input clock definition in the IP XDC file 
instead of the OOC XDC file, which are, as follows:

° IP contains a clock definition connected to an input buffer

° IP contains a clock definition internal to the IP

In OOC mode, Vivado synthesis does not insert I/O buffers. 

° If your custom IP port has an instantiated input buffer, leave the input clock 
definition in your IP XDC file. 

° If the input clock definition is defined on an internal element of the IP, such as a 
Flip-Flop or a GT, leave the input clock definition in the IP XDC file. 

° If your use case does not fall into one of the two categories, move the clock 
definition to the OOC XDC file.

After the OOC XDC file is created, set the USED_IN property to out_of_context. This 
marks the XDC file to be processed in the OOC flow only. 
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Chapter 2: IP Packaging Basics
IMPORTANT: The USED_IN property for an OOC XDC file should be {synthesis implementation 
out_of_context}. If it is only set to out_of_context, it is not used during synthesis or 
implementation.

Processing Order of Constraints
The Vivado IP that deliver constraints are processed either before or after the user design 
constraints. For more information on using constraints, see this link in the Vivado Design 
Suite User Guide: Using Constraints (UG903) [Ref 5].

IMPORTANT: An XDC marked as OUT_OF_CONTEXT is processed before all other XDC files used in the 
IP, including those marked to have a PROCESSING_ORDER value of EARLY. The default value of 
PROCESSING_ORDER is NORMAL. There is also a LATE value.

When creating your custom IP, you must determine the order in which the constraints are 
processed in the context of a user design. The IP packager inherits the processing order set 
on the constraint files in the project. Set these properties properly in your project prior to 
packaging the IP. The constraints delivered for an IP only support two processing orders: 
EARLY and LATE. All constraints marked as the default of NORMAL are converted to EARLY. 

By default, top-level user constraints have the processing order set to NORMAL, which 
comes between EARLY and LATE. This way an IP can provide output clocks that the 
top-level reference in an EARLY XDC as well as allow for the top-level constraints to 
override an IP constraint if needed. 

If an IP constraint has a dependency to a top-level constraint, such as a top-level clock 
object, place the constraint in an XDC marked as LATE. This ensures that the required 
object is present when the IP constraint is processed. In the case of the IP being synthesized 
out-of-context, the OOC XDC provides the top-level clock object. 

Note: Xilinx IP XDC files that have their PROCESSING_ORDER property set to LATE are named 
<IP_NAME>_clocks.xdc. This naming convention is not required for a custom IP. 

Most constraints for an IP belong in the EARLY processing order. The constraints marked 
for LATE require user constraints prior to processing. This generally refers to clock 
dependencies.

Upgrading Custom IP
A custom IP upgrades as every other IP in the Vivado IP catalog. The difference is how the 
custom IP is edited to create a new version or revision to which to upgrade. For more 
information on the process of upgrading IP, see this link in the Vivado Design Suite User 
Guide: Designing with IP (UG896) [Ref 8].
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Chapter 2: IP Packaging Basics
For custom IP, you do not have to upgrade when a newer version is available in the IP 
catalog. All versions, if accessible in the IP catalog, are available for customization and use; 
however, when using Xilinx IP in your custom IP, moving to a new Vivado release could 
cause the custom IP to become locked. 

This IP lock is because the IP used in the custom IP must be upgraded. If you do not want 
to update any information for the custom IP, you must ensure all the output products are 
fully generated from the previously supported release.

IMPORTANT: For Xilinx IP, only one version of an IP is delivered in each release of the Vivado Design 
Suite.

In the report IP status example, shown in the following figure, the status reports the IP 
definition has missing subcores. 

In this case, the sub-core is missing because the Xilinx IP used by the custom IP has a new 
version. Because Vivado only supports the latest version of a Xilinx IP, the previous version 
originally used when creating the custom IP no longer exists.

To create a new version of the custom IP, you must edit the IP in an Editing IP project or in 
the original project from which the IP was packaged. For more information on creating and 
using an Editing IP project, see the Editing an Existing Custom IP section.

RECOMMENDED: Review the Versioning and Revision Control section to understand how to properly 
maintain versions of your custom IP.

In the Vivado project used to edit the custom IP, upgrade the Xilinx IP. After the upgrade of 
the IP is complete, ensure that the custom IP operates as expected and make any additional 
modifications to keep functionality.

After the custom IP is updated with the necessary changes, ensure the Package IP window 
has fully merged the changes and repackage the IP. For more information on the Package IP 
window, see Packaging a Specified Directory in Chapter 3.

Referencing the previous report IP status example, in Figure 2-2, with the updated custom 
IP, the report IP status view now reflects the new available version.

X-Ref Target - Figure 2-1

Figure 2-1: Locked Custom IP in Report IP Status View
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Chapter 2: IP Packaging Basics
The custom IP can now be upgraded to the latest version supported with the current Vivado 
release. 

Editing an Existing Custom IP
After you create a custom IP, you can modify that IP. There are a few possible options for 
editing the existing custom IP:

• Edit the IP in an existing project

• Edit the IP in a new editing IP project

For more information on creating a version for your custom IP, see Versioning and Revision 
Control.

IMPORTANT: When you package a custom IP, the IP definition is placed at a location relative to the 
project source files. Add the files to your custom IP below the IP definition file; this ensures that the 
newly merged files are added as relative paths instead of absolute paths.

Editing Your IP in an Existing Project
To edit your IP in an existing project, open the existing project from which the IP was originally 
created and then, from the Tools menu, select Create and Package New IP.

Note: This option only exists for projects with an associated IP-XACT component.xml file.

A dialog box opens, as shown in Figure 2-3, and asks if you want to overwrite the existing 
definition.

X-Ref Target - Figure 2-2

Figure 2-2: Custom IP with Minor Version Change
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Chapter 2: IP Packaging Basics
With the Package IP window open, add, remove, or modify the source files in the project or 
adjust settings in the Packaging Steps. For more information on each of the packaging 
steps, see Chapter 4, Packaging IP.

After you complete the modifications to your custom IP, select the Review and Package step 
in the Package IP window and select Re-Package IP.

IMPORTANT: When you package a custom IP, the IP definition file (xml) is placed at a location relative 
to the project source files. Add the files to your custom IP in a directory below the IP definition file (xml); 
this ensures that the newly merged files are added as relative paths instead of absolute paths.

Editing Your IP in a New Editing IP Project 

If you do not have the original packaging project available, or would like to edit the IP in a 
new project, you can open a new editing IP project from the Vivado IDE, as follows:

1. Open any Vivado project with the repository for your custom IP.

2. From the Flow Navigator, select the IP Catalog.

3. Right-click the custom IP you would like to edit, and select Edit in IP Packager, as 
shown in Figure 2-4.

X-Ref Target - Figure 2-3

Figure 2-3: Overwrite Existing IP Definition
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Chapter 2: IP Packaging Basics
4. The Edit in IP Packager dialog box opens for you to select the name and location of the 
edit IP project, as shown in Figure 2-5.

5. Click Next, then OK.

X-Ref Target - Figure 2-4

Figure 2-4: Edit in IP Packager Option

X-Ref Target - Figure 2-5

Figure 2-5: Edit in IP Packager Dialog Box 
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Chapter 2: IP Packaging Basics
A new Vivado project opens that contains the contents of the custom IP. The 
component.xml from the custom IP is associated with the new edit IP project and the 
Package IP window becomes available. 

From this project, you can add, remove, or modify the source files in the project or 
adjust settings in the packaging steps. 

For more information on each of the packaging steps, see Chapter 4, Packaging IP.

IMPORTANT: When adding files to your custom IP through the edit IP project, ensure that you have 
selected the Copy sources into IP Directory in the Add Sources dialog box. 

6. After you complete the modifications to your custom IP, select the Review and Package 
step in the Package IP window and select Re-Package IP. 

You are prompted if you would like to close the edit IP project. 

7. Select Yes and, if you have previously selected the Delete project after packaging 
option in the IP Packager project settings, the edit IP project is deleted. 

You can always open a new edit IP project if more edits are required.

Editing a Packaged Block Design
When packaging a block design, the IP definition contains the files associated with the 
block design (BD); however, the diagram for the BD is not maintained. 

Only the HDL wrapper files which represent the diagram are included in the IP definition 
along with the associated IPs that were used within the BD. 

IMPORTANT: Because the diagram of the block design is not maintained, it is not recommended to 
modify the packaged Block Design through the Edit in IP Packager flow.

When opening a packaged block design in the Edit in IP Packager flow, the project is not 
recognizable compared to the original source block design. The modifications required in 
this state are, as follows:

° Add the newly required IP or edit one of the existing IPs similar to a standard RTL 
project.

° Manually edit the top-level wrapper file to connect and instantiate any additional or 
edited IP.

To modify a packaged block design (BD), follow the recommended method:

1. Add the original BD source into a new Vivado project or use the original Vivado project 
that contained the BD source.
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Chapter 2: IP Packaging Basics
2. Open the BD and make any necessary modifications. 

3. Package the BD following the Using the Create and Package IP Wizard. 

4. Return to the Vivado project that uses the custom IP and upgrade the IP to the latest 
version. 

IMPORTANT: To avoid errors when elaborating a BD that was packaged as an IP, name the BD 
something other than the default name. If the packaged BD uses the default name, and if you were to 
use this in a project and add it to a BD with which also uses the default name (or any name that 
matches), the project fails synthesis.

When packaging the BD after the modifications, it is important to use the same vendor, 
library, and name as for the previous IP VLNV. If the same information is not used, the 
upgrade process is not available for the modified custom IP. For more information about 
versioning, see Versioning and Revision Control.

Setting an Enablement Expression
In the Vivado IP packager, you can use an expression for the following methods:

• Enabling or disabling ports or interfaces

• Enabling or disabling customization parameters

• Calculating the value of a customization parameter

The syntax that evaluates the expression can reference parameters defined through the 
Customization Parameters page in the Package IP window.

The variable name of the parameter in the expression view is the parameter name. The 
variable name is case-sensitive and requires a ($) sigil prefix before the variable name. For 
example, a parameter named BAUD_RATE has an expression variable reference of 
$BAUD_RATE.

To create a functioning enablement or an editable expression, use the variable names with 
numeric and comparison operators to form a Boolean expression. For example: 

$BAUD_RATE == 115200 || $BAUD_RATE == 57600

To create a functioning dependency expression, use the variable names to form a 
mathematical expression to generate a value. For example: 

$NUM_OF_BYTES*8

Note: See http://wiki.tcl.tk/583 to ensure conformity with expression rules.
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Versioning and Revision Control
Custom IP created by the IP packager contains a field for the version. The version 
information is set in the Identification page of the Package IP window, see Chapter 4, 
Packaging IP. 

A <major#.minor#> numbering scheme unifies the IP version numbers, and a revision 
number field distinguishes slight changes in the same version. For more information, see 
the Xilinx IP Versioning page available from the Xilinx website: Vivado IP Versioning [Ref 1]. 

Each time the IP is re-packaged, if the version is not changed, the IP packager increments 
the revision number automatically. The Vivado IP catalog supports only a single version of 
a Xilinx-created IP per release; however, custom IP is not required to adhere to this behavior. 

A custom IP can have multiple versions available in the IP catalog, and you can select any 
available version. You can also upgrade the currently used version of a custom IP to the 
latest available version.

IMPORTANT: The IP packager does not automatically archive and save previous versions of custom IP. 
Each time the IP is re-packaged, the IP location overwrites the data with the newer version of the IP.

To save a specific version of your IP prior to re-packaging, the recommended flow is to 
manually copy the packaged IP directory contents to a new location. The IP catalog can 
point to this new location to ensure the catalog can show both the original and updated 
version of the custom IP.

For more information on setting the custom IP location, see Using the Create and Package 
IP Wizard in Chapter 3.

When using revision control with your custom IP definition, the recommendation is to use 
an external repository location for your custom IP. By default, the Create and Package New 
IP wizard chooses a location relative to the project source files. By selecting a location 
outside of the project, the custom IP is separated from the project structure. Placing the 
project structure into revision control is not recommended. For more information on setting 
the custom IP location, see the Using the Create and Package IP Wizard.

RECOMMENDED: When you create an external repository, place the entire custom IP directory into the 
revision control system to preserve all the necessary outputs from the IP packager.

For more information about revision or source control in the Vivado Design Suite, see this 
link in the Vivado Design Suite User Guide: Design Flows Overview (UG892) [Ref 3]. You 
might also want to review the following video: 

VIDEO: See Vivado Design Suite QuickTake Video: Vivado Design Suite Revision Control. 
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Chapter 3

Using the Create and Package New IP 
Wizard

Introduction

IMPORTANT: Some Xilinx IP requires licensing. After purchasing the required license, you can include 
Xilinx IP in your design. 

The Vivado® Integrated Design Environment (IDE) Create and Package New IP wizard lets 
you create and package the following:

• IP using source files and information from a Vivado Design Suite project

• Block diagram (BD) XCI and XCIX files

• IP from a specified directory

• A template for AXI4 peripherals that includes: 

° HDL files

° Drivers

° A test application

° A bus functional model (BFM), which requires special licensing

° An example template

The Create and Package New IP wizard can generate Xilinx-supported AXI interfaces. These 
are:

• AXI4: For memory-mapped interfaces, which allows burst of up to 256 data transfer 
cycles with a single address phase. 

• AXI4-Lite: A light-weight, single transaction memory-mapped interface.

• AXI4-Stream: For high-speed streaming data.

For more information on the Xilinx adoption of AXI, see the Vivado Design Suite: AXI 
Reference Guide (UG1037) [Ref 18]. 
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Chapter 3: Using the Create and Package New IP Wizard
Note: For the simple purpose of adding custom RTL for use in IP integrator, the Module Reference 
feature is available and described in Vivado Design Suite User Guide: Designing IP Subsystems Using 
IP Integrator (UG994) [Ref 17].

Using the Create and Package IP Wizard
From an open Vivado Project, the Create and Package New IP wizard takes you step-by-step 
through the IP creation and packaging steps. 

To run the Create and Package New IP wizard, from the Tools menu, select Create and 
Package New IP. The first page of the Create and Package New IP wizard opens, as shown 
in the following figure.

Use the wizard to accomplish one of these tasks:

° Package a new IP for the Vivado IP Catalog: Guides you through the process of 
creating a new Vivado IP using source files and information from your current 
project or specified directory.

° Create a new AXI4 Peripheral: Create a new AXI4 peripheral that includes HDL, 
drivers, a test application, and a BFM example template.

IMPORTANT: You must acquire a BFM licensing file if you intend to use BFM models.

Click Next. 

X-Ref Target - Figure 3-1

Figure 3-1: Create and Package New IP Wizard
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Chapter 3: Using the Create and Package New IP Wizard
The Create Peripheral, Package IP, or Package a Block Design page opens, as shown in 
the following figure.

Select one of the options:

° Package your current project: See Packaging Your Current Project.

° Package a block design from the current project: See Packaging a Block Design.

° Package a specified directory: See Packaging a Specified Directory.

° Create a new AXI4 peripheral: See Creating a New AXI4 Peripheral.

Make your selection, and click Next. 

The next dialog box option differs, based upon the Choose Create or Package option you 
selected. The following sections describe these options.

X-Ref Target - Figure 3-2

Figure 3-2: Create and Package New IP Wizard: Create Peripheral, Package IP, or Package a Block 
Design 
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Chapter 3: Using the Create and Package New IP Wizard
Packaging Your Current Project
The Package Your Current Project option lets you package the files associated with your 
current Vivado project. The IP packager attempts to gather the necessary information about 
your IP and create a basic IP package in a specified location. 

When you select this option, the wizard page updates with the available options for 
packaging the current project as shown in the following figure. 

In the Package Your Current Project dialog box, (Figure 3-3), make your selections from the 
following options:

• IP location: The directory in which the IP Packager creates the IP Definition. The 
default is the project sources directory. Generally, the IP location is the /sources 
directory of the project. This location, if all the files are copied into the project, is 
relative to all the project files. 

X-Ref Target - Figure 3-3

Figure 3-3: Create and Package New IP Wizard: Package Your Current Project 
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Chapter 3: Using the Create and Package New IP Wizard
If files are stored remotely from the project source directory, the IP location is 
determined based upon where the majority of project files are relative.

If a location is selected outside of the hierarchical file paths of the project files, the 
Vivado IDE prompts you to copy the project source files into the indicated IP location 
directory. This process copies all the remote files to the IP location into a directory 
based on their category (for example, src/, sim/). 

The IP packager heuristic always copies remote files based on the file category 
regardless of IP location name.

The Vivado IDE creates a new temporary editing project in the IP location for editing 
and modifying the newly created packaged project.

• Packaging IP in the project: If the project you are packaging includes IP, the following 
options determine how the IP is included in the newly packaged IP. 

° Include .xci files: Packages only the IP customization file. The Vivado IDE generates 
the IP output products with the newly created parent IP.

° Include IP generated files: Packages the generated HDL and XDC sources from the 
IP customization.

When including only the XCI files in the packaged IP, this creates an association 
between the parent IP and enables the packaged XCI files to be managed by the 
Vivado IDE. This allows the Vivado IDE to upgrade IP to the latest release by using 
the IP upgrade instructions as described in this link to Vivado Design Suite User 
Guide: Designing with IP (UG896) [Ref 8].

RECOMMENDED: As only one version of Xilinx IP is delivered in each release, the parent IP can become 
locked if the associated XCI file has a new release. Vivado will attempt to automatically upgrade the 
XCI files as they are delivered; however, Xilinx strongly recommends that you repackage the parent IP 
with an upgraded XCI from the latest Vivado Design Suite to maintain functionality.

When you include IP-generated files, the generated HDL and XDC output products of the IP 
customization are packaged. This removes any reference of the original IP customization 
and treats the IP as project source files.
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Chapter 3: Using the Create and Package New IP Wizard
Click Next. You are prompted to confirm the copy of the source files, as shown in the 
following figure:

The New IP Creation page summarizes the information that the Create and Package New 
IP wizard heuristically gathers about the design.

Click Finish to complete packaging and open the IP packager.

When this step completes, review the packaging steps shown in the Package IP view in 
Chapter 4, Packaging IP.

Packaging a Block Design
The following steps demonstrate how a block design within a Vivado Project can be 
packaged.

1. The Package a block design from the current project option lets you package the files 
associated with a block design (BD) in your current project, as shown in Figure 3-5.

X-Ref Target - Figure 3-4

Figure 3-4: Confirm Copy Source Dialog Box 
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Chapter 3: Using the Create and Package New IP Wizard
The drop-down menu allows the selection of the desired block design to package.

IMPORTANT: Ensure that your block design is open prior to packaging. 

2. Click Next.

3. In the Packaging your IP dialog box, shown in the following figure, make your selections 
from the following options:

° IP Location: The directory in which the IP packager creates the IP Definition. The 
default is the project sources directory.

° Packaging IP in the project: The only option here is to Include .xci files. This 
options packages only the IP customization files. The Vivado IDE generates the IP 
output products with the newly created parent IP.

X-Ref Target - Figure 3-5

Figure 3-5: Package a Block Design from the Current Project 
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Chapter 3: Using the Create and Package New IP Wizard
4. Click Next.

The New IP Creation page summarizes the information that the Create and Package New 
IP wizard heuristically gathers about the design.

5. Click Finish to complete the packaging, and open the Package IP view.

f VIDEO: For more information, see the Vivado Design Suite: QuickTake Video:Packaging Custom IP for 
Using in IP Integrator. 

Next, review the packaging steps in Chapter 4, Packaging IP. 

X-Ref Target - Figure 3-6

Figure 3-6: Options in Packaging your IP Page
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Chapter 3: Using the Create and Package New IP Wizard
ELF File within a Packaged Block Design 
Often times a processor based block design contains an ELF file associated with it. This 
section describes the process to package a block design with an ELF association. Consider 
this MicroBlaze-based block design which has a separate ELF file associated for synthesis 
and simulation.

When packaging this type of a block design, after you go through the Create and Package 
an IP wizard, you see a Critical Warning dialog box as shown in Figure 3-8.

The Critical Warning states that packaging a block design with an ELF file for simulation is 
currently not supported. In fact, the simulation ELF file gets overwritten with synthesis ELF 
file as can be seen in Figure 3-9.

X-Ref Target - Figure 3-7

Figure 3-7: Packaging a block design with ELF Association

X-Ref Target - Figure 3-8

Figure 3-8: Critical Warning while packaging a block design with separate ELF files
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Chapter 3: Using the Create and Package New IP Wizard
After packaging the block design, it can be instantiated in another block design by adding 
the repository containing the packaged block design to the project.

X-Ref Target - Figure 3-9

Figure 3-9: Simulation ELF file is overwritten by Synthesis ELF

X-Ref Target - Figure 3-10

Figure 3-10: Packaged block design instantiated in another block design
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Chapter 3: Using the Create and Package New IP Wizard
While the synthesis flow would work perfectly as the ELF file used for synthesis is packaged 
with the packaged bd, the simulation flow won’t work since the simulation ELF file is not 
packaged. To overcome this issue, one can add the simulation ELF file in the project and set 
the Scope to Ref and Scope to Cell properties appropriately to point to the process 
instance. 

Add a simulation ELF file to Simulation Sources.

The Sources window shows the simulation ELF file. 

X-Ref Target - Figure 3-11

Figure 3-11: Add simulation ELF file in the Simulation Sources

X-Ref Target - Figure 3-12

Figure 3-12: Sources window showing the ELF file for simulation
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Chapter 3: Using the Create and Package New IP Wizard
Set the SCOPED_TO_CELLS and SCOPED_TO_REF properties in the Properties window as 
shown in the following figure. Now you can run simulations with the ELF file added for 
simulation.

Packaging a Specified Directory
When you package a specified directory, you can package the files in a specific directory 
within the file system. There are inference rules which assist in packaging the IP correctly. 
The following table describes the directory structure recommended for inferring an IP.

Using the directory structure shown in Table 3-1, the IP packager attempts to populate the 
contents into each corresponding file group. In the synthesizable sources directory, the 
files are filtered by the .sv, .v*, and .xdc extensions. For all other directories, files are 
populated.

° If the simulation directories do not exist, the IP packager populates the 
synthesizeable sources into the simulation file sets.

° If the directory structure of the specified directory cannot be recognized, the IP 
packager recursively searches for synthesizable source files, and adds files to the 
synthesis and simulation file groups.

X-Ref Target - Figure 3-13

Figure 3-13: Setting SCOPED_TO_CELLS and SCOPED_TO_REF

Table 3-1: Directory Inference Recommendation

Source Type Directory Inference

Synthesizable Sources src/, hdl/

Simulation Sources sim/, simulation/

Example Sources example/, ex/, examples

Testbenches testbench/, tb/, test/

C Sim Models cmodel/, c/

Documents docs/, doc/, documents/
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Chapter 3: Using the Create and Package New IP Wizard
To package a specific directory, select the Package a Specified Directory option to open 
the associated wizard, as shown in the following figure.

Make your selections from the following options:

° Directory: The location of the IP. 

° Package as a library core: The checkbox defines the IP as a library core, which is IP 
that is available in the IP repository, but is not visible in the IP catalog.

IMPORTANT: Use the Package as a library core for IP that is not to be used as a standalone IP. This 
option lets you reference the IP from the IP Repository, but does not make the IP visible in the IP 
catalog.

Click Next.

In the Edit in IP Packager Project Name dialog box, set the following information:

° Project name: Name of the project created with the generated IP definition.

° Project location: Directory where the design sources exist and the Edit IP Packager 
project is located.

X-Ref Target - Figure 3-14

Figure 3-14: Create and Package New IP Wizard: Package a Specified Directory
Creating and Packaging Custom IP 38
UG1118 (v2017.1) April 25, 2017 www.xilinx.com

Send Feedback
UG1118 (v2017.2) June 7, 2017

https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1118&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Creating%20and%20Packaging%20Custom%20IP&releaseVersion=2017.2&docPage=38


Chapter 3: Using the Create and Package New IP Wizard
RECOMMENDED: Keep file path lengths under 80 characters to avoid the path length limitation in 
Windows.

Click Next. The New IP Creation page summarizes the information that the Create and 
Package New IP wizard heuristically gathers about the design.

Click Finish to complete packaging, and open the Edit IP Packager project. See Chapter 4, 
Packaging IP, for more information.

Creating a New AXI4 Peripheral
To create a new AXI4 peripheral, from the Choose Create Peripheral or Package IP dialog 
box, select Create a new AXI4 peripheral, and click Next.

Enter the IP peripheral details: 

° Name: The name of the IP. 

° Version: IP version that reflects the <major#.minor#.Rev#> version scheme.

° Display name: The name of the IP that shows in the IP catalog. 

You can have different names in the Name and Display name fields; however, the 
Display name must be intuitive enough that any change in Name can reflect 
automatically in the Display Name. 

° Description: The IP description to share with an end-user of the IP.

° IP location: IP packager automatically adds the IP repository location. 

° Overwrite existing: Check this box to override an existing repository.

Click Next. 

Add interfaces to your IP, based on the functionality and the required AXI type, shown in the 
Figure 3-15.
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Chapter 3: Using the Create and Package New IP Wizard
To include interrupts to be available in your IP, check the Enable Interrupt Support option.

Figure 3-15 shows that generated IP supports edge or level interrupt (generated locally on 
the counter) and those interrupts can be extended to input ports by user and IRQ output.

• Add an interface using the Add button . 

• Delete an interface using the Remove button . 

The data width and the number of registers vary, based upon the AXI4 selection type. 

Click Next, and review your selections. 

The details of your IP are listed in the final wizard page, as shown in Figure 3-16.

X-Ref Target - Figure 3-15

Figure 3-15: Add Interfaces Dialog Box
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Chapter 3: Using the Create and Package New IP Wizard
The following Next Steps options are available after you create the peripheral IP:

° Add IP to the repository: Lets you add IP to the IP repository.

° Edit IP: Lets you edit the IP. 

° Verify peripheral IP using AXI4 BFM Simulation Interface: Lets you use an AXI4 
BFM simulation interface (licensing is required to use AXI4 BFM simulation).

° Verify peripheral IP using JTAG interface: Creates a block design with which you 
can debug your IP module in hardware for a system with JTAG-to-AXI IP. See the 
Vivado Design Suite User Guide: Programming and Debugging (UG908) [Ref 12] for 
more information about the Vivado debug tools.

You can generate a bitstream and then validate the register writes and reads (from the 
sample Tcl script generated by the tool for your design) in the debug mode after the 
targeted device is programmed. You can do so by connecting to the board server from 
hardware manager, programming the board, and then sourcing the Tcl script. See the 
Vivado Design Suite User Guide: Using Tcl Scripting (UG894) [Ref 15] for more information.

After you create the peripheral, you have the option to add custom logic and make the 
peripheral a custom IP. 

X-Ref Target - Figure 3-16

Figure 3-16: Create and Package New IP Wizard: Peripheral Summary Dialog Box 
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Chapter 3: Using the Create and Package New IP Wizard
See the Vivado Design Suite Tutorial: Creating and Packaging Custom IP (UG1119) [Ref 21] 
for a demonstration. When this step completes, review the packaging steps shown in the 
Package IP view in Chapter 4, Packaging IP.

Using XPMs
For details on XPMs, see Vivado Design Suite User Guide: System-Level Design Entry (UG895) 
[Ref 9]. 

For details on the various XPMs and their parameterization options, see the UltraScale 
Architecture Libraries Guide (UG974) [Ref 24].

Note: In the 2017.1 Vivado release and beyond, XPMs are enabled automatically in project mode, 
and in non-project mode are used automatically during synthesis/implementation.

Note: UNIMACROs are not supported in the UltraScale® device architecture.
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Chapter 4

Packaging IP 

Introduction
This chapter describes the features for adjusting and packaging a custom IP. The Vivado® IP 
packager is the interface between the Vivado integrated design environment (IDE) and the 
IP-XACT™ component file. 

IMPORTANT: Some Xilinx IP requires licensing. After purchasing the required license, you can include 
Xilinx IP in your design. 

In the Vivado IP packager, the following packaging steps are available to customize the 
custom IP definition:

• Identification: The identification information for custom IP.

• Using the Compatibility Page: The device support for custom IP.

• Using File Groups: The location and behavior of the files for custom IP.

• Ports and Interfaces: The list of top-level ports or interfaces of custom IP.

• Addressing and Memory: The address space and memory maps required for custom IP.

• Customization GUI: The GUI customization layout of the custom IP.

• Review and Package: A summary and packaging of the custom IP.

After packaging the custom IP definition, you can use the IP within your current project or 
point the custom IP definition repository path to use in another Vivado project.
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Chapter 4: Packaging IP
Identification
The Identification page, shown in the following figure, is the first section of the IP packager. 
The information is initially populated based on the information from Project Settings > IP, 
described in Using the Packager Settings. The Vivado IP packager heuristically determines 
the remainder of the information during packaging.

The Vendor, Library, Name, and Version (VLNV) of the IP definition uniquely identifies 
the IP in the Vivado IP catalog. The following fields are available to describe the 
identification of package IP:

° Vendor: Identifier for the vendor that displays in the VLNV of the IP definition.

° Library: Library in which the IP belongs. This is also the identifier for the library 
that displays in the VLNV of the IP definition. See Versioning and Revision Control. 

° Name: Name of the IP. This is also the identifier for the name that displays in the 
VLNV of the IP definition.

° Version: Version of the IP. This is also the identifier for the version that displays in 
the VLNV of the IP definition. See Versioning and Revision Control. 

° Display name: The Vivado IP catalog display name.

X-Ref Target - Figure 4-1

Figure 4-1: Package IP: Identification Page
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Chapter 4: Packaging IP
° Description: The Vivado IP catalog description.

° Vendor display name: Vendor display name.

° Company url: Vivado IP catalog display of the company URL.

° Root directory: Working directory of the packaged IP. The directory controls both 
the location of the input and the output files.

° XML file name: Name and location of the IP-XACT standard XML file.

° Categories: The list of category names in which the IP belongs.

IMPORTANT: Only one VLNV can exist within the IP Repository. The IP names must be concise with 
words separated by underscores. 

Each IP within the IP catalog have taxonomy for organization purposes, as described by the 
Vivado Design Suite User Guide: Designing with IP (UG896) [Ref 8]. These classifications are 
controlled by the categories set during IP packaging.

In the Categories list, each category is separated by the forward slash (/) character. Initially, 
Vivado defaults the custom IP to the UserIP category.

Adding or Creating New Categories for Packaged IP
To add a custom IP category, select an existing category and add a name for your packaged 
IP, or click the Add button  to open the Add IP Category dialog box. Any subsequent 
levels described in the name should be separated by a ‘/’. 

The following figure shows the Add IP Category dialog box.

X-Ref Target - Figure 4-2

Figure 4-2: Add IP Category
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Chapter 4: Packaging IP
Click OK. The name displays in the IP Category list, as shown in the following figure.

The newly packaged IP is then located in the designated IP Category.

Removing Categories from your IP
If an IP has multiple categories selected, you can remove the previously associated 
categories. A packaged IP must have at least one category to which it is associated. 

To remove categories from your IP, select the category in the Categories section of the 
Identification page and click the Remove button .

You can additionally remove categories from the Add IP Category dialog box by 
de-selecting the categories in the list.

Note: The IP packager removes any custom IP categories that do not contain any IP.

X-Ref Target - Figure 4-3

Figure 4-3: IP Categories Dialog Box 
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Using the Compatibility Page
The IP Compatibility page, shown in the following figure, configures the specific Xilinx parts 
or device families compatible with your custom IP.

The list is initially populated with the 7 series Kintex® device family with the with the 
Life-cycle set to Production. Any Xilinx device family and/or devices supported by the 
Vivado IDE can be included within the family support list of the custom IP. Any device family 
or part that is not listed in the Compatibility list is incompatible for that IP.

The Life-cycle property informs the user of the IP compatibility with the selected IP use 
case. Within the Compatibility list, each device family or part added can have their own 
Life-cycle property. 

The following options describe the Life-cycle for a given part or family, as follows:

° Beta

° Discontinued

° Hidden

° Pre-Production

° Production

° Removed

° Superseded

X-Ref Target - Figure 4-4

Figure 4-4: Package IP: Compatibility 
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Setting the property to Discontinued, Hidden, Removed, or Superseded ensures that the 
IP does not appear in the IP catalog for the associated device family or part.

Adding a Xilinx Family or Part
To set the compatibility of your custom IP to a Xilinx family or part, you can add the devices 
by adding a family explicitly, or by using a regular expression. Adding a family or part 
explicitly requires you to select the individual desired devices or parts from a tree. Adding 
a family using regular expressions requires that you select the multiple devices through a 
specific syntax.

Adding a Family or Part Explicitly

To explicitly add a family or part, click the Add button  in the toolbar of the 
Compatibility page, and select Add Family Explicitly. Ensure that you select the Life-cycle 
property from the drop-down list; the default value is Beta. Then click OK.

Note: You can adjust the Life-cycle property later, if necessary.

Adding a Family or Part Using Regular Expressions

The syntax for the regular expression search is <familyname>{regexp}. For example, 
this regular expression example returns all Virtex®-7 XT and Virtex®-7 HT devices.: 

virtex7{xc7v[hx].*}

Click the Add button  in the toolbar of the Compatibility page, and click Add Family 
using Regular Expression. In the Add Family dialog box, shown in the following figure, set 
the regular expression syntax to add the desired device family and parts.

Click the Life-cycle property from the drop-down menu. The default value is Beta, then 
click OK.

Note: You can change the Life-cycle property later, if necessary.

X-Ref Target - Figure 4-5

Figure 4-5: Add Family Dialog Box for Regular Expressions
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Using File Groups
The File Groups page, shown in the following figure, provides a listing of files of your 
custom IP. 

Each file is grouped into specific groups that define the behavior of the file and its use. 
When you run the Create and Package IP wizard, the file locations in the file groups are 
initially determined by the wizard either by using the file sets of the project, or by 
heuristically determining the information from the directory structure of the IP source files.

After you place the files in file groups, you can adjust each file or group based on the 
custom IP requirements.

Two sections separate files into different file groups:

° Standard: Standard File Groups describes the standard file groups. For many 
custom IP, the Standard file group list contains the necessary groups required for 
packaging an IP for reuse.

° Advanced: Advanced File Groups describes the advanced file groups. The 
Advanced file group list contains additional advanced features available for your 
custom IP.

Different functions categorize the file groups. The groups are collapsed at the name of the 
file group followed by a number in parenthesis, which corresponds to the total number of 
files in the group. Expand the file group to expose the list of associated files within the 
group.

X-Ref Target - Figure 4-6

Figure 4-6: Package IP – File Groups
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The expanded File Groups view shows an expanded list of files for the synthesis file group 
as illustrated in the following figure.

The following properties in the column list are associated with the files of the file group:

° Name: File name within the hierarchy tree.

° Library Name: Determines the library name used by Vivado synthesis or simulation.

° Type: Type of the file in the file group (for example; Verilog Source, XDC, or Tcl 
Source). 

Note: When used with a Verilog source file, set the results in the file_type property to 
Verilog Header. 

° Is Include: Mark the file as an include file (for example, a Verilog Header file). 

° File Group Name: The file property to determine to which file group the file is 
associated. This property is read-only.

° Model Name: Top-level design name. The Model Name is a required property and 
applies directly to the file group. This value is set for any synthesis, simulation, or 
implementation files.

RECOMMENDED: Generally, it is recommended to use the extension of .vh or .h for include 
files.

X-Ref Target - Figure 4-7

Figure 4-7: File Group List Expansion 
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Adding or Removing Files to File Groups

When adding or removing files to and from your custom IP, the recommended flow is to 
modify the files to the Vivado project and merge the changes using the Package IP window. 

For more information on how to add and remove files to your Vivado project, see Vivado 
Vivado Design Suite User Guide: System-Level Design Entry (UG895) [Ref 9].

With the Package IP window open, a merge changes banner opens that prompts you to 
update the contents of the file groups with the updated files in the Vivado project. Similar 
to the Create and Package IP wizard, the merged files are associated with the necessary file 
groups.

The IP packager merges files from the active sources fileset into the Synthesis and 
Simulation file groups. Files that are in the sources fileset, but not used for synthesis are 
not added to either the Synthesis or Simulation file groups. Files associated with the active 
simulation fileset are merged only into the Simulation file group. A warning is issued for 
any un-referenced file in the active fileset. 

IMPORTANT: Files added to the Vivado project should be copied into the project. Files associated with 
the IP should be contained in a path within the IP directory to ensure proper reuse

To add or remove files from a packaged IP, go to Tools > Package IP use the Add  or the 
Remove  button.

If any changes were made in the file the Merge changes from File Groups Wizard 
hyperlink in the banner displays, as shown in the following figure.

X-Ref Target - Figure 4-8

Figure 4-8: Merge Changes from File Groups Wizard Hyperlink 
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Manually Adding Files to File Groups

You can manually add files in the Package IP window, but this is not recommended as the 
wizard ensures that the files are associated to the correct file groups.

To manually add a file to a file group, right-click the respective file group and click Add 
Files, and use the Add IP Files dialog box to add or create the files for the file group, then 
click Finish.

Note: The Add IP Files dialog box lets you add files to one file group at a time only.

Manually Removing Files from a File Group

You can manually remove files in the Package IP window, but this is not recommended as 
Package IP window becomes out-of-sync with the associated Vivado project.

To manually remove a file from a file group, in the File Groups page, right-click the 
respective file and click Remove File.

Copying Files from a File Group

For files that already exist in the Package IP window, you can copy a file or file group using 
the Copy To option, which extends the list of available file groups. The list contains the file 
groups listed within the File Groups page as well as additional commonly used groups.

If selecting a file group, the Copy To option copies the child files under the file group to the 
specified destination group. In the File Groups page, select a file or file group, right-click 
and click Copy To and click the destination file group from the list in the extension menu.

Adding a File Group

To add a file group, click the Add button .

From the list of files in the File Groups page, right-click and select Add File Group from the 
drop-down list.

Select from the file group list, which includes the group description, as shown in Figure 4-9. 
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After you click OK, the customization parameters list populates, based on the parsing of the 
top-level HDL source file.

Customization Parameters
Two folders for parameters display in the Customization Parameters list:

° Customization Parameters: Customization Parameters shown in the IP 
Customization GUI.

° Hidden Parameters: Customization Parameters not shown in the IP Customization 
GUI.

By default, parameters parsed from the wizard are listed in the /Customization 
Parameters folder. These parameters display in the GUI of the custom IP during 
customization. Hidden parameters are not intended for direct editing by the user. During 
customization of the custom IP, these parameters are not available for the user to edit. 
These parameters are generally dependent upon the parameters shown in the 
Customization GUI to determine their values.

X-Ref Target - Figure 4-9

Figure 4-9: Add File Group
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Importing Parameters from Top-Level HDL Files
The parameters are initially determined during the Create and Package IP wizard by parsing 
the top-level HDL file. When you want to update parameters from the top-level HDL source 
file due to a change to the HDL source after packaging, you can re-import the parameters.

When importing parameters from the HDL, the values are determined at the time of import 
or merge. If a parameter is calculated based on an expression, the expression is evaluated at 
the time of import. To keep the expression, you must edit the parameter to create the 
XPATH expression. For more information on editing a parameter, see Editing a Parameter.

To import IP parameters, from the Customization Parameters page, right-click and select 
Import IP Parameters, and click one of the following options from the Import IP 
Parameters dialog box.

° Top-Level source file: Contains the top-level entity or module of the custom IP.

° Top entity name: The name of the top-level entity or module that contains the 
parameters of your custom IP.

° Make all imported HDL parameters visible: Sets all the imported parameters to 
be visible in the customization GUI.

° Modify names of all imported HDL parameters: Lets you change the imported 
HDL parameter names.

Click Finish to move to the next page.

Adding, Removing, and Editing a Parameter
You can create or remove parameters for use in your custom IP. When adding parameters, 
you can only add parameters for use in the Customization GUI. To add a parameter to 
reference the top-level HDL, the source files must be modified and the parameters must be 
re-imported.

You can remove any parameter from the list regardless if it is referenced from the top-level 
HDL. If an HDL parameter is removed from the Customization Parameters list, a default 
value is required in your top-level HDL source.

Adding a Parameter

To add a parameter, in the Customization Parameters page, right-click and select Add 
Parameter from the drop-down list, then enter the name of the new parameter.

Note: This parameter name is not the display name of the parameter in the Customization GUI.

After you click OK, the Edit IP Parameter dialog box opens for parameter customization.
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Removing a Parameter

Select one or more parameters in the Customization Parameters page, right-click and select 
Remove Parameter from the drop-down list.

Note: Any parameter dependent on the remove parameter flags as an error.

Editing a Parameter

You can customize parameters in the Customization Parameters page for how it displays in 
the IP Customization GUI. You can edit the display name, data format, data range, default 
value, and visibility. In the Customization Parameters page, right-click the respective 
parameter and select Edit Parameter. The Edit IP Parameter dialog box opens with the 
detailed information set for the selected parameter as shown in the following figure.

X-Ref Target - Figure 4-10

Figure 4-10: Edit IP Parameter
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Many options are available to define the use of the parameter for the custom IP; depending 
upon the selections within the dialog box, certain options become unavailable. 

The following options in the dialog box are associated with the display properties of the 
parameter.

° Name: This is the name of the parameter. This is a read-only property.

° Visible in Customization GUI: When checked, the parameter becomes visible in 
the Customization GUI.

° Show Name: When checked, the display name of the parameter lists next to the 
display object in the Customization GUI. 

° Display Name: Displays in the Customization GUI for the parameter. When the IP is 
customized, this is the text that displays next to the value that a user can set. This 
can be a simple name or a small description.

° Tooltip: Text that displays when you hover over the parameter in the Customization 
GUI. This can be a simple name or a small description of the parameter.

The following options are associated with the data formatting and restrictions for the 
parameter.

° Format: This defines the data format of the parameter. The data format selection 
determines the supported values the user can use to customize the IP. Depending 
upon the selection, the remaining options adjust, based on the requirements for the 
format.

- Long: Integer input

- Float: Decimal input

- Bool: Boolean input

- BitString: Hex input

- String: String input

° Editable: This defines if the parameter is editable by the user, or only under certain 
conditions. 

- Yes: This selection indicates the user can edit the parameter in the 
Customization GUI. This is the default setting.

- No: This selection indicates the user cannot edit the parameter in the 
Customization GUI. If displayed, the parameter is read-only during 
customization. The value of the parameter is determined by the default value or 
expression.

- Dependent: This selection indicates the user can only edit the parameter in the 
Customization GUI under certain conditions. 
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If selected, a new option displays to set the expression as shown in the following 
figure. 

The evaluated editability expression, if true, allows the parameter to be editable. 
For more information on setting an editability expression, see Setting an Enablement 
Expression.

° Dependency: This defines how the parameter value is determined during 
customization.

- Yes: This selection indicates the value of the parameter is dependent on another 
parameter. If selected, a new option displays to set the expression to evaluate 
the parameter value, as shown in the following figure. The evaluated 
dependency expression is used as the parameter value. 

For more information on setting a dependency expression, see Setting an 
Enablement Expression.

- No: This selection indicates the value is not dependent on another parameter, 
and the value is set directly by the user or by the default value.

° Specify Range: Defines the bounds by which the parameter value is set. If not 
selected, the value can be any value in the selected data format, and the IP 
Customization GUI does not ensure that the value is within the expected bounds for 
usage.

- List of values: This selection limits the value choices for the parameter in a 
predefined list. The list box defines the valid list of values for the parameter, as 
shown in the following figure.

X-Ref Target - Figure 4-11

Figure 4-11: Expression Field for Editable Option

X-Ref Target - Figure 4-12

Figure 4-12: Expression Field for Dependency Option
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° To add a value to the list, click the Add button  on the side bar. All created 
elements default the text to value. 

° To change the element text, double-click the value in the list to enable 
modification. The elements in the list display in the IP Customization GUI in the 
same order they appear in the list. 

° To change the order of the elements: 

- Click the element and then select the Move Up button  to move the element 
up by 1. 

- Click the Move Down button  to move the element down by 1.

° To remove an element, select one or more elements in the list, and click the 
Remove button .

° Range of integers: This selection limits the value of the parameter to a specific 
range of numeric integer values. The Minimum and Maximum range restricts the 
integer values to the user for the parameter, as shown in the following figure.

A value set outside the specified range within the IP Customization GUI reports as an 
error. If checked, the Show Range option displays the minimum and maximum 
range of the integer values in the Customization GUI. 

° Pairs: This selection limits the value choices for the parameter from a predefined 
list similar to the list of values restriction; however, you can show the selections in 

X-Ref Target - Figure 4-13

Figure 4-13: List of Values Restriction 

X-Ref Target - Figure 4-14

Figure 4-14: Range of Integers Restriction
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the IP Customization GUI in a different format. A Key/Value pair list controls the 
value of the parameter (Figure 4-15).

° To add a key/value pair to the list, Click the Add button  on the side bar. All 
created elements default the key to key and the value to value. 

° To change the element text, double-click the element in the list to enable 
modification. The elements in the list display in the IP Customization GUI in the 
same order they appear in the list. 

° To change the order of the elements:

- Click the element and then select the Move Up button  to move the element 
up by 1. 

- Click the Move Down button  to move the element down by 1.

° To remove an element, select one or more elements in the list and click the Remove 
button .

The last set of options describe the display object and the default value of the parameter.

° Show As: This describes the display object used for the parameter in the 
Customization GUI. This is a read-only property that is set depending the options 
defined within the dialog box.

° Layout: This describes the display layout of a Radio Group. The values are Vertical 
and Horizontal. In all other fields, Not Applicable is displayed.

° Default Value: This defines the default value for the parameter. If an IP is 
customized without any modification to the parameters, the parameter is set by the 
value defined in this option.

X-Ref Target - Figure 4-15

Figure 4-15: Pairs Restriction
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Ports and Interfaces
The Ports and Interfaces page, shown in Figure 4-16, provides a listing of ports and 
interfaces of the custom IP.

After completing the Create and Package IP wizard, the ports and interfaces table populates 
based on the parsing of the top-level HDL source file. During the parsing of the top-level 
ports, if an interface can be heuristically determined, the interface is inferred automatically.

The following properties column list are associated with a port or interface:

° Name: The port or interface name. The direction of the port is described in the 
preceding icon.

° Interface Mode: The mode of the interface (master or slave).

° Enablement Dependency: The expression to determine whether the port or 
interface is enabled. For more information, see Setting an Enablement Expression.

° Is Declaration: Indicates if this interface is a pre-declaration of a dynamically 
created interface. 

° Direction: The direction of the port.

° Driver Value: The driver value of the port if disabled.

° Size Left: The value of the most significant bit (MSB).

° Size Right: The value of the least significant bit (LSB).

X-Ref Target - Figure 4-16

Figure 4-16: Package IP – Ports and Interfaces
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° Size Left Dependency: The dependency expression to determine the value of the 
most significant bit.

° Size Right Dependency: The dependency expression to determine the value of the 
least significant bit.

° Type Name: The port type (std_logic or std_logic_vector).

Updating Ports from a Top-level HDL
The recommended flow for adding or removing ports to the Custom IP is to modify the 
top-level HDL file in the Vivado project and merge the changes using the Package IP 
window. With the Package IP window open, a merge changes banner appears that prompts 
you to update the contents of the ports and interfaces list from the updated file in the 
Vivado project.

To update ports from a top-level HDL, go to the Flow Navigator > Package IP to open the 
Package IP window. In the Ports and Interfaces page of the Package IP window, click the 
Merge changes from Ports and Interfaces wizard hyperlink in the banner.

The IP packager only monitors the top-level HDL file for file changes. It does not monitor 
secondary or ancillary files that, if changed, could affect the top-level ports. 

For cases where ancillary files are modified and the merge changes banner is not present, 
the same behavior can be accessed through the Tcl design environment. To merge changes 
from Ports and Interfaces page using Tcl, type the following in the Tcl Console:

ipx::merge_project_changes ports [ipx::current_core]

Importing Ports from a Top-Level HDL
The ports and interfaces are determined during the Create and Package IP wizard by 
parsing the top-level HDL file. When you want to change ports due to a change to the HDL 
source after packaging, you can re-import the ports.

IMPORTANT: When you re-import the top-level source file, all pre-existing HDL parameters and 
associated data are removed.

To import ports, from the Ports and Interfaces page, right-click and select Import IP Ports. 
In the Import Ports from HDL dialog box, and provide the following information, then click 
Finish:

° Top-Level source file: The top-level source HDL file that contains the top-level 
entity or module of the custom IP.

° Top entity name: The name of the top-level entity or module that contains the 
ports of your custom IP.
Creating and Packaging Custom IP 61
UG1118 (v2017.1) April 25, 2017 www.xilinx.com

Send Feedback
UG1118 (v2017.2) June 7, 2017

https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1118&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Creating%20and%20Packaging%20Custom%20IP&releaseVersion=2017.2&docPage=61


Chapter 4: Packaging IP
Editing a Port
You can modify the behavior for ports on your custom IP by defining restrictions on its use, 
as follows:

1. Click a port in the Ports and Interfaces view, right-click and select Edit Port.

2. In the Edit Port dialog box, shown in Figure 4-17, set the following options:

° Driver Value: If the port is disabled during customization, this is the driver value to 
the port.

° Port Presence: This option determines if the port can be disabled. 

- The Mandatory option defines that the port are always available for the custom 
IP. 

- The Optional option defines that the port is disabled when the expression in 
the text box is false. For more information on setting an enablement expression, 
see Setting an Enablement Expression.

X-Ref Target - Figure 4-17

Figure 4-17: Edit Port Dialog Box
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Removing a Port
You can remove a port from the Ports and Interfaces page, but this is not recommended. 
Removing the port deletes the object reference to the port in the IP, but the port still exists 
in the HDL. The end result would be an undriven or unconnected port when the IP is 
customized. 

To remove a port, select one or more ports in the Ports and Interfaces page, right-click and 
click Remove Port.

Adding or Removing Bus Interfaces
Interfaces provide the ability to group signals into a common grouping to use between IP 
in a Vivado IP integrator design. You can add an existing interface or create a new interface 
for a group of ports in your custom IP to simplify connectivity within IP integrator. 

Adding an Existing Bus Interface

To add an existing bus interface, in the Ports and Interfaces page, right-click and press the 
Add Bus Interface option

The Add Interface dialog box opens for you to modify the properties related to the 
interface. For more information on editing an interface, see Editing an Existing Interface.

Creating a New Bus Interface Definition

To create a new bus interface, click the ports in the Ports and Interfaces page, right-click and 
select Create Interface Definition. For more information on creating an interface 
definition, see Chapter 5, Creating New Interface Definitions.

Removing a Bus Interface

To remove an interface or several interfaces, select one or more interfaces in the Ports and 
Interfaces page, right-click and click Remove Interface. After you remove the interface, the 
ports previously associated return to the Ports and Interface table as unassociated ports.

Auto Inferring an Interface
There are two options for automatically inferring an interface: bus or single-bit: Infer the 
bus interface by selecting from a full interface list, or infer a single-bit interface from a list 
of single-bit signal interfaces

IMPORTANT: The port names must match exactly as specified in the interface so the auto-inference 
heuristics can properly match the port list to the correct interface signals.
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Auto Inferring a Bus Interface
To auto infer a bus interface, click all the ports related to the interface, right-click and select 
Auto Infer Interface. Alternatively, you can click the Auto Infer Interface  button on 
the sidebar. In the Auto Infer Interface Chooser dialog box, shown in the following figure, 
select the interface to infer, then click OK.

TIP: If the auto inference heuristics are unable to infer the interface, you must manually identify the 
bus interface ports through the Add Bus Interface option. See Adding or Removing Bus Interfaces.

Auto Inferring a Single Bit Interface
To auto infer a single bit interface, click the port, right-click and select Auto Infer Single Bit 
Interface. From the extended menu, shown in the following figure, select the interface you 
want to infer.

X-Ref Target - Figure 4-18

Figure 4-18: Auto Infer Interface Chooser

X-Ref Target - Figure 4-19

Figure 4-19: Auto Infer Single Bit Interface Drop-Down 
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Editing an Existing Interface
To edit an interface, click the interface in the Ports and Interfaces page, right-click and 
select Edit Interface. In the Edit Interface dialog box, select the desired options, then click 
OK.

Editing the Interface Information
The General tab of the Edit Interface dialog box, shown in the following figure, displays the 
instance information for the interface.

Enter the following information, then click OK: 

° Interface Definition: The name of the interface definition.

° Name: The name of the interface instance. This is the name that displays in the 
Customization GUI and the IP integrator canvas.

° Mode: The mode of the interface instance (Master or Slave).

° Display name: The display name of the interface.

° Description: The description of the interface.

° Interface presence: This option determines if the interface can be disabled. 

X-Ref Target - Figure 4-20

Figure 4-20: Edit Interface - General Tab
Creating and Packaging Custom IP 65
UG1118 (v2017.1) April 25, 2017 www.xilinx.com

Send Feedback
UG1118 (v2017.2) June 7, 2017

https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1118&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Creating%20and%20Packaging%20Custom%20IP&releaseVersion=2017.2&docPage=65


Chapter 4: Packaging IP
- The Mandatory option defines that the interface is always available for the 
custom IP. 

- The Optional option defines that the interface is disabled when the expression 
in the text box is false. 

For more information on setting an enablement expression, see Setting an 
Enablement Expression.

Mapping the Interface Ports
The Port Mapping tab, see the following figure, displays the mapping of the interface ports 
to the ports of the custom IP. The ports are listed in two columns representing the logical 
ports of the interface and the physical ports of the custom IP. Ports mapped to the interface 
display in the summary table at the bottom of the view.

Click the interface port in the left column, and select the associated physical port from the 
right column, then click the Map Ports button.

For large interfaces, the List Options modifies the port displayed in the columns to 
simplify connectivity. The options are:

° Filter Incompatible Physical Ports: Hide physical ports that do not match the 
correct direction of the selected interface port.

° Hide Mapped Ports: Hide physical and logical ports that have been previously 
mapped.

The mapped ports are listed in the Mapped Port Summary section of the view. You can 
un-map all the previously mapped ports, or selectively un-map ports in the summary view.
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Adding and Removing Interface Parameters
The Parameters tab, shown in the following figure, displays the parameters defined for the 
interface. Some bus interfaces require associated parameters. The Vivado IDE identifies 
some parameters automatically, and recommends those parameters for the interface. 

Click the Add Button. 

X-Ref Target - Figure 4-21

Figure 4-21: Edit Interface – Port Mapping
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Specify the following for each parameter as you add them:

° Name: The name of the parameter.

° Description: The parameter description.

° Display Name: The parameter display name.

° Value: The parameter value.

° Parameter Types: The type of parameter.

Click OK.

Adding Recommended Parameters

If the interface has predefined parameters, you can add the recommended parameters by 
right-clicking in the Parameters tab, selecting Add Recommended Parameter. In the Add 
IP Parameter dialog box, select the recommended parameter, and then click OK.

TIP: If the Add Recommended Parameter is not available, no predefined parameters are available for 
that interface definition.

Adding Custom Parameters

If you want to define your own parameters for the interface, you can add your own 
parameter by right-clicking and selecting Add Bus Parameter. In the Add Parameter dialog 
box, select the name of the parameter, then click OK.

X-Ref Target - Figure 4-22

Figure 4-22: Edit Interface – Parameters
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Removing Parameters

To remove parameters, select one or more parameters in the table, right-click Remove Bus 
Parameter.

Addressing and Memory
The Addressing and Memory page, shown in the following figure, lets you add a 
memory-map or address space to the IP.

If the Create and Package IP wizard was able to automatically infer an interface for your 
custom IP, the Addressing and Memory step is populated also if an address mapping 
requirement for the interface was identified.

X-Ref Target - Figure 4-23

Figure 4-23: IP Addressing and Memory
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Identifying an Interface for Address Mapping
If an interface has not been previously mapped, click the Addressing and Memory Map 
wizard link.

Note: Alternatively, right-click and select IP Addressing and Memory Map Wizard from the 
pop-up menu if an interface has already been mapped.

In the Addressing and Memory wizard, click Next. 

In the Choose IP Interface page, shown in the following figure, select the interface to add a 
memory map, and click Next.

In the Choose IP Object Name page, select the name for the memory map, and click Next, 
then, on the Summary page, click Finish to complete the wizard.

Adding an Address Parameter
To add an address, select a memory-map from the list, then right-click, and click Add 
Address Space. If the interface is an AXI slave, the dialog box shows as Add Block Space. 
In the dialog box, select the name of the new address, and click OK.

The selected memory map in the Addressing and Memory view now contains a child 
address space section with the newly-created address. The address list contains the 
following columns:

° Name: Address name.

° Display Name: Address display name.

X-Ref Target - Figure 4-24

Figure 4-24: IP Addressing and Memory Configuration Wizard - Choose IP Interface
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Chapter 4: Packaging IP
° Description: Detailed description.

° Base Address: Base address.

° Range: Range of the block.

° Range Dependency: The dependency expression for the address range.

° Width: Width of address.

The Segment option is available if the address space is an AXI Master interface. Select the 
cell of the address to enter the desired information.

Add or Remove an Address Parameter
To add an address parameter, click the address in the list, right-click and select Add 
Address Space Parameter. In the dialog box, select the name, and click OK. Select the cell 
of the address block parameter to enter the information.

X-Ref Target - Figure 4-25

Figure 4-25: Memory Map with Address Block 
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Chapter 4: Packaging IP
RECOMMENDED: Give the interface in a meaningful name that reflects the functionality.

To remove an address parameter, select the address parameter in the list, and right-click 
and select Remove Address Space Parameter.

The IP Addressing and Memory Wizard Summary page opens, which describes the name of 
the new space map as well as to which interface the address space references. Review the 
summary, and click Finish.

Customization GUI 
The Customization GUI page, shown in the following figure, provides an environment for 
the GUI customization of your custom IP. This page lets you customize the layout by adding 
display pages, parameter groupings, and text fields.

After you setup the parameters of your IP in the Customization Parameters page, you can 
customize the GUI to change how a user interacts with your custom IP. 

Initially, the Customization GUI generates a layout with all the viewable parameters 
displayed on a single page of the GUI. 

X-Ref Target - Figure 4-26

Figure 4-26: Package IP – Customization GUI
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Chapter 4: Packaging IP
The two columns that display in the Customization GUI page are:

° Layout: A hierarchical display of the layout which allows for modification of the 
custom IP GUI.

° Preview: A preview display of the Customization GUI of the custom IP.

The Layout column displays a hierarchical view of the customization GUI components. 

Within a Window component, which is the top-level to which to associate the 
customization components, there are a total of four components that you can create to 
customize the display of your custom IP GUI:

° Page: An individual page to display the parameters of the custom IP.

° Group: A collection of parameters to display in a single group.

° Parameter: A parameter of the custom IP.

° Text: A text field to display any necessary information in the GUI.

Each component can be associated hierarchically to other components within the 
customization layout. The Group, Parameter, and Text components can be within a Page 
or Group. The Page component can only be a child of the Window component.

The preview view shows you a real-time feedback view of the customization GUI as it would 
appear if the IP was customized through the IP catalog. 

The components in the preview display in the same order in which they are arranged in the 
layout. You can change the order in which the components display by dragging the 
components in the layout column to the location you want.

The Customization GUI page retains its information, thereby allowing for a simple iterative 
process for updating the custom IP because it only affects the parameters that were added 
or removed.

Adding Parameters to the Layout
To add parameters to the layout, do the following, click the hierarchical level (page or 
group) you want to add the parameter, right-click and select Add Parameter.

Note: Alternatively, you can click the Add  button from the toolbar.

In the Add Parameter dialog box, select the following options, and click OK.

° Available Parameters: The available parameters of the custom IP. These are 
parameters that have not been previously added to the Customization GUI.

° Display Name: The label text displayed for the parameter in the Customization GUI.
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° Tooltip: The text displayed for the tooltip when hovering over the parameter in the 
Customization GUI.

° Show Label: The option to disable the label (Display Name) of the parameter.

Adding Groups to the Layout
To add groups to the layout, do the following:

Click the hierarchical level (page or group) you want to add the group, right-click and select 
Add Group from the popup menu.

Note: Alternatively, you can click the Add button  from the toolbar.

In the Add Group dialog box, select the following options, and click OK.

° Display Name: Text that displays as a header for the group in the Customization 
GUI.

° Tooltip: Text that displays for the tooltip when hovering over the group in the 
customization GUI.

° Layout: The option to display the components of the group vertically or 
horizontally.

Adding Pages to the Layout
To add pages to the layout, do the following:

Click the Window component, right-click, and select Add Page.

Note: Alternatively, you can click the Add button  from the toolbar.

In the Add Page dialog box, select the following options, and click OK.

° Display Name: The label text displayed on the tab for the page in the 
Customization GUI.

° Tooltip: The text displayed for the tooltip when hovering over the page contents in 
the Customization GUI.

Adding Text to the Layout
To add text to the layout, click the hierarchical level (page or group) to which you want to 
add the text, then right-click and select Add Text.

Note: Alternatively, you can Click Add button  from the toolbar.

In the Add Text dialog box, select the following options, and click OK.
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° Display Name: The label text displayed in the layout and the tooltip for the text in 
the customization GUI.

° Text: The text displayed in the Customization GUI.

Review and Package
The Review and Package section, shown in Figure 4-27, provides a summary of the IP and 
information about the settings you selected after packaging. 

The IP is initially packaged at the end of the Create and Package IP wizard. If any changes 
occur to any of the packaging steps of the custom IP, the custom IP must be repackaged for 
the changes to go into effect.

The summary information is the identification data of the custom IP from the Identification 
section. To change the information, make the modifications in the Identification section, as 
described in Identification.

The After Packaging section contains information about the Vivado IDE actions after 
packaging is complete. 

X-Ref Target - Figure 4-27

Figure 4-27: Package IP – Review and Package
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The information that describes how the packager behaves is based on the IP Packager 
Settings, described in the Using the Packager Settings, are, as follows:

° Archive Information: Select whether an archive of the IP is going to be created.

° Repository Information: The location of the IP for the Vivado repository manager.

In the IP Project Settings, you have an option of creating an archive of the custom IP 
definition. By default, the custom IP is generated at the IP root directory in which the source 
files are referenced relatively from the IP root directory location, if possible. 

When an archive is created, the Vivado IDE compresses all the relatively referenced files into 
a single archive file. This archive file can be used in a Vivado repository by using the single 
archive file or extracting the archive file in a desired repository location.

After the IP is packaged, the custom IP is available in the IP catalog of the current Vivado 
project. The Vivado IDE automatically adds the IP root directory of the custom IP to the 
Repository Manager in the IP Project Settings. The IP root directory is the location of 
custom IP definition and the location required to add to the Repository Manager of other 
Vivado projects that require the custom IP.

Re-Packaging IP
To re-package IP, click the Re-Package IP button at the bottom of the Review and Package 
view. If successful, click OK on the Package IP popup dialog box.

IMPORTANT: Repackaging an IP and changing the default parameter values does not change the 
customization parameters in the IP instance. Each IP instance must be manually changed to the new 
default value if that change is required.

Creating an Archive of the IP
To create an archive of the IP, click the Create archive of IP option in the IP Packager Project 
settings, as described in Using the Packager Settings. To open the IP Packager settings, click 
the Edit packaging setting hyperlink.

In the After Packaging section, click the edit hyperlink to change the name and location of 
the archive.

Note: By default, the archive name is <Vendor>_<Library>_<Name>_<Version#>.zip.

In the Package IP dialog box, select the following options, and click OK.

° Archive name: The name of the archive file. 

° Archive location: The location where the archive file is created.
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Chapter 5

Creating New Interface Definitions

Introduction
Interface definitions provide the capability to group functional signals into a common 
interface grouping to use between IP in a Vivado® IP integrator diagram. The interface 
definition give you more a comprehensible diagram, and also enforces a standardized 
expectation that signals are designed to work between IP pairs.

Xilinx® provides many interface definitions, including standardized AXI protocols and other 
industry standard signaling; however, some legacy or custom implementations have unique 
IP signaling protocols. 

You can define your own interface and capture the expected set of signals, and ensure that 
those signals exist between IP.

The Create Interface Definition option uses the IP-XACT industry standard specification. 
The interface definitions use two files that together correspond to a bus definition file 
(myInterface.xml) and an abstraction definition file (myInterface_rtl.xml). 

The Vivado IDE uses the created interface definition to support mapping logical ports and 
inferring bus interfaces on the IP Definition in the IP packager.

The IP packager bus interface algorithms are almost completely data-driven, based on the 
bus definition and the algorithm works similarly with Xilinx-provided definitions as well as 
user created interfaces.   

AXI4 memory-mapped and AXI4-Stream interfaces have additional DRC checks beyond the 
data-driven heuristics.

See Inferring Signals for more information about signal naming and inferring signal names.
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Creating a New Interface Definition
Select Tools > Create Interface Definition, the Create Interface Definition dialog box 
opens, as shown in the following figure.

Select one of the interface types from the following options:

° Create new interface definition: Creates an empty interface, which is the typical 
use case.

° Extend from: Creates a new interface using the existing interface definition port 
list as a template. This is an advanced feature.

If you create a new interface definition, the Interface tab opens without any 
pre-determined ports in the Ports list. You can add the ports as necessary.

If you extend from an existing interface, the Interface tab opens with the ports 
pre-populated in the Ports list. You can add or delete the ports as necessary.

In the Identification fields, enter the following information for the interface:

° Vendor: The vendor of the interface. This is also the identifier for the vendor that 
displays in the interface definition VLNV. Provide the vendor information using the 
standard Internet domain order.

X-Ref Target - Figure 5-1

Figure 5-1: Create Interface Definition Dialog Box
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Chapter 5: Creating New Interface Definitions
° Library: The library in which the interface belongs. This is also the identifier for the 
library that displays in the interface definition VLNV.

° Name: The name of the interface, which is also the identifier for the name that 
displays in the interface definition VLNV.

° Version: The version of the interface, which is also the identifier for the version that 
displays in the interface definition VLNV.

° Location: The directory where the pair of interface XML files are created.

Click OK to complete the interface creation.

Using the Interface Definition Editor
After you finish creating the new interface definition, the workspace editor for the interface 
opens in the Interface Definition Editor for modifications, as shown in the following figure.

The following fields are available to describe the identification of the interface definition:

° Vendor: The vendor of the interface definition. This is also the identifier for the 
vendor that displays in the VLNV of the interface definition.

° Library: The library in which the interface belongs. This is also the identifier for the 
library that displays in the VLNV of the interface definition.

° Name: The name of the interface. This is also the identifier for the name that 
displays in the VLNV of the interface definition. Use short interface names because 
the IP block diagram has limited space.

X-Ref Target - Figure 5-2

Figure 5-2: Interface Definition Editor
Creating and Packaging Custom IP 79
UG1118 (v2017.1) April 25, 2017 www.xilinx.com

Send Feedback
UG1118 (v2017.2) June 7, 2017

https://www.xilinx.com
http://www.xilinx.com/about/feedback.html?docType=User_Guides&docId=UG1118&Title=Vivado%20Design%20Suite%20User%20Guide%3A%20Creating%20and%20Packaging%20Custom%20IP&releaseVersion=2017.2&docPage=79


Chapter 5: Creating New Interface Definitions
° Version: The version of the interface. This is also the identifier for the version that 
displays in the VLNV of the interface definition.

° Description: The description of the interface definition.

° Display Name: The display name of the interface definition.

° Location: The name and location of the IP-XACT standard XML file.

Adding Logical Ports to the Interface
On the ports list, right-click and select Add Port. Alternatively, you can click the Add button 

 on the toolbar. The following figure shows the Add Port dialog box.

Enter the required information, as follows:

° Display Name: The name of the logic port. In the Xilinx convention, these names 
are uppercase and are not prefixed with the name of the interface. 

° Description: Enter a human-readable description for the logical port. Any 
transaction signaling must be described.

X-Ref Target - Figure 5-3

Figure 5-3: Add Port
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° Default Value: When the port is optional, IP Integrator uses this default value to 
drive the in mode port when unconnected.

Note: If this port is part of the control logic, and is optional, it is important that the value is 
set to allow transactions to continue and not stall.

In the Master and Slave sections of the dialog box, set the following:

° Width: Required bit width of the mapped port for master mode bus interfaces 
exposed on an IP. Values are: -1 (undefined width), 1 (single bit signal), or a fixed 
value.

° Presence: Set to either required or optional, indicating if the logical port is required 
to be mapped in master mode bus interfaces exposed on an IP. Allowed values are: 
optional, required, and illegal.

° Direction: Required port mode when mapped for master mode bus interfaces 
exposed on an IP. Values are in, out, and inout.

Note: Often the slave and master widths are the same.

IMPORTANT: Typically the slave and master directions are opposite. If the directions are the same, IP 
Integrator might not be able to properly directly connect the master and slave.

In the Type section of the dialog box, set the following:

° Address: Check this option when the logical port serves as an address line.

° Data: Check this option when the logical port carries data and is not a control, 
addressing, or clock/reset.

° Clock: Check this option when the logical port is a clock line.

° Reset: Check this option when the logical port is a reset line.

Click OK.

Adding Logical Ports from a Previously Defined Interface
As when creating the definition of the interface, you can additionally extend interfaces to 
the custom interface. From the ports lists, right-click and select Copy Ports From. 
Alternatively, click the Copy Interface Ports button  on the toolbar.

In the Copy Interface Ports dialog box, select the interface which logical ports from which to 
copy, then click OK. Ports from the selected interface are populated in the Ports list.

Note: Any previously defined port with the same name as one of the imported ports is overwritten.
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Chapter 5: Creating New Interface Definitions
Editing Logical Ports
After you create a logical port, a new row displays in the Create Interface Definition table. 
The logical port columns displays the information described in the Add Port dialog box 
when adding a logical ports. To edit the port information, select the column cell for the port 
you want to edit. 

Setting Tristate Signaling
The following cells provide advanced information for tristate signaling and can be specified 
to allow a cross-over like connection between masters and slaves with a triple of tristate 
signals.

Because a device does not have true tristate lines inside the fabric, a triple of signals (in, 
out, tristate) represents a tristate pair (in, out, tristate).

When you create an interface with the triple of signals, add the following information, which 
is required to allow connectivity between masters and slaves.

• Tristate Role: This indicates if the port is part of a tristate triple of signals, and which 
role. Non-tristate ports leave this cell blank. Values are in, out, and tristate. 

• Group: When there are multiple tristate triples in the interface, it is important that the 
three signals be grouped together. This field must have the same string identifier 
entered for the three ports that form the same unique tristate.

Completing the Interface Definition Creation
When you have completed providing the required information for the Create Interface 
Definition option, click the Save button centered at the bottom of the view to save the pair 
of XML files. To throw away edits, click the Discard button.

Re-Editing Interface Definitions
To edit an interface definition, in File > Open IP-XACT File, browse to either of the bus 
definition file (my_interface.xml) or abstraction definition file 
(my_interface_rtl.xml ). Both files must be in the same directory for the Vivado GUI 
to edit the definition correctly. 

Using a New Interface Definition
Similar to IP Definitions, the IP-XACT bus definition files must be in a repository path for 
the IP packager and IP integrator tools to use the files. 
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Chapter 5: Creating New Interface Definitions
RECOMMENDED: Structure your /IP repository to have a single directory with an /interfaces 
subdirectory to contain the interface definition files, and a peer IP subdirectory to contain your IP 
definition files. A repository path must be added at, or preceding, the directory that contains the IP 
definition file. For example, <repository_path>/IP/interface or 
<repository_path>/IP/IP.

To see the interface definition files in the IP catalog, ensure that the catalog is organized to 
display by repository. See Using the Packager Settings for the display settings. Select the 
user repository with the new interface definition files. A tab displays the names and number 
of interfaces.

Note: After the interface definitions are recognized in the projects catalog, the IP packager lets the 
IP Definition feature create bus interfaces, based on the bus definition, including the ability to infer 
the bus interface port mapping.

IMPORTANT: The IP packager uses a name-matching heuristic which is based on the logical port 
names matching the physical ports in the IP. IP packager automatically detects AXI interfaces when the 
names of the HDL modules ports follow the <interface_name>_<AXI signal name> convention. 
For example, s_axi_awvalid, where s_axi is the interface name and awvalid is one of the AXI 
signal names used in the interface. Module ports with the same <interface_name> are mapped into 
the named interface. 

TIP: Use short interface names because the IP block diagram has limited space.
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Chapter 6

Encrypting IP in Vivado

Introduction
The Vivado Design Suite® supports version 2 (V2) of the IEEE-1735-2014, Recommended 
Practice for Encryption and Management of Electronic Design Intellectual Property (IP) 
[Ref 32]. 

TIP: In the event of any discrepancies or errors in this document, the IEEE 1735-2014 standard 
document supersedes this content. 

Licensing
The IEEE-1735 v2 encryption feature requires a license which you can request. See Answer 
Record 68071 for details.

Note: Encryption license features are tied to specific Vivado versions. When requesting a license, 
include the exact version of Vivado (for example, 2016.4, 2017.1) for which a license is required.

Scope
The scope of IP encryption and protection in the Vivado Design Suite tool flow is limited up 
to the point of bitstream generation. Protection of the bitstream itself requires encryption 
of the bitstream on the programmed Xilinx® device, a step that usually resides in the hands 
of the IP user, not the IP creator. See this link to the Vivado Design Suite User Guide: 
Programming and Debug (UG908) [Ref 12] BISTREAM.ENCRYPTION.ENCRYPT property, 
for more information on bitstream encryption. 

Although there are many different formats of design source files, IEEE-1735-2014 only 
applies to Verilog, SystemVerilog, and VHDL formats. These RTL standards are also 
governed by the IEEE, and it is by mutual agreement that those standards will allow 
IEEE-1735 to define behavior in IP security until such a time as the recommendations in IEEE 
1735 can be retrofitted into the original language standards contained in the language 
reference manuals (LRMs). Popular netlist formats, like EDIF, are not covered by IEEE 1735.
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Chapter 6: Encrypting IP in Vivado
IEEE 1735 Trust Model
A trust model answers the basic question, “Who decides if the security provided by a given 
flow is sufficient.” Past trust models favored the tool providers; each tool vendor could 
choose what to show or not show for protected IP after that IP enters the control of the tool 
chain for each vendor. In some cases, like simulation tools, a common understanding has 
been reached between tool vendors, and a de-facto approach to visibility and protection is 
adopted.

IEEE 1735 aims for a trust model based upon the concerns of the IP author. The assumption 
is that the IP author should be able to specify how their secured IP can be viewed, used, 
how access can be revoked later, even in different vendor tools. There is a balance; however, 
in that all tool vendors might not be able to build the same levels of security into their tools. 
The trust model can be summed up by the following: Encryption of source code is a 
mandate by the IP author that they expect their IP to be secure. Tool behavior should 
default to the maximum reasonable protection tool is capable of while still accomplishing 
tool goals.

In some cases, default tool behavior may be either too restrictive or too permissive. IEEE 
1735 based encryption allows for the IP author to state their desired behavior for target 
tools. If a tool vendor cannot adhere to any specific requests, the tool should stop 
processing, unless a special exemption is granted for that tool from a particular vendor.

Access Rights Management
IEEE-1735-2014 V2 lets an IP author manage access rights to their IP, expressing how they 
want various vendor tools to interact with the IP. These access rights are placed into 
sections of the RTL code, inside the encryption definition area. 

The following sections describe the types of rights, as follows: 

• Common Rights

• Vendor-Specific Rights

• Conditional Rights
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Chapter 6: Encrypting IP in Vivado
Common Rights
Common rights specify general guidelines that apply to all EDA tools. These rights apply to 
all the tool-vendors specified by the IP author in the encryption definition area. If a tool 
vendor cannot comply with a common right, the tool vendor must error out and stop 
processing the encrypted file. 

Vendor-Specific Rights
The IP author can also grant each tool vendor specific rights that apply just to their tool 
flow. An example of this would be controlling the behavior of Vivado Logic Analyzer probes, 
which is unique to Xilinx. The value of an access right in the vendor-specific area overrides 
the value in the common rights block of the same name for the specified vendor. 

Conditional Rights
IEEE-1735-2014 V2 also introduces a language construct which allows IP authors to specify 
different access rights under different conditions. An example of a conditional right might 
include not allowing decryption of the IP for simulation. 

Understanding IEEE 1735 Structural Elements
The basic regions in a design protected with IEEE-1735-2014 V2 are, as follows:

• Definition area: The IP author determines which tool vendors to support, and what 
access rights to grant to all tools, or to a specific tool. Most of the definition area 
remains in plain-text, even after encryption, because there are basic formatting 
instructions that the design tools need to properly decrypt the encrypted data. 

• Encrypted Key Definition: Contains the encryption keys for tool vendors supported by 
the IP. 

Although technically part of the Definition area above, the key definition must, itself, be 
encrypted by the encryption tool in order to ensure that only authorized vendors can 
access the key and decrypt the encrypted payload. 

• Encrypted payload: The encrypted IP Verilog, SystemVerilog, or VHDL source code. 

• Plain-text payload: An unencrypted portion of the IP source-code. Within a single RTL 
source file, some content can be encrypted, and other content can be unencrypted. 
You do not need to encrypt the whole design file. 

IMPORTANT: In keeping with 1735 recommendations, Vivado handles encryption at the granularity of 
the module or entity and architecture pair. 
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Chapter 6: Encrypting IP in Vivado
The following sections define different sections of the definition area, and related pragmas 
that must be defined in the IP source code to support encryption. The examples are written 
in VHDL form. The Verilog and System Verilog syntax is the same except the `pragma 
protect keywords in Verilog replaces the `protect keyword in VHDL. 

Version and Other Pragmas
IEEE-1735-2014 V2 compliance level is specified by the Version pragma, as follows: 

`protect version = 2

TIP: Version 1 (V1) of IEEE-1735 -2014 is supported by Xilinx under an early access program. Improper 
use of V1 can inadvertently expose your design. Please contact your local sales office or Applications 
Engineer for more information. 

The encryption tool might add some optional pragmas to identify itself, as follows:

`protect encrypt_agent = “XILINX”
`protect encrypt_agent_info = “Xilinx Encryption Tool 2016" 

Common Block Definition
Common rights are placed into commonblock section. The beginning and end of this block 
are defined by the following pragmas, as follows: 

‘protect begin_commonblock
...
‘protect end_commonblock

Common Rights

The set of common rights is defined in the following table, with a description of the default 
value, valid values as defined by the IEEE specification, and valid values as accepted by the 
Vivado tools. The term delegated means that the IP author is delegating an access right to 
the tools to do what is needed to process the IP. 

Rights must evaluate to the Xilinx valid values under all circumstances. Evaluation to 
non-supported values causes the tool to stop processing the encrypted data. 
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Vendor-Specific Tool Block Definition
Tool vendor specific rights are placed into vendor specific toolblock sections. There has 
to be at least one tool block for each encrypted block. This block also contains the 
encryption key definition for the tool vendor. 

The beginning and end of this block are defined by the following pragmas: 

‘protect begin_toolblock
...
‘protect end_toolblock=””

TIP: Tool blocks are vendor-specific; consequently, each vendor has a separate toolblock defining 
their encryption key and access rights.

Table 6-1: Common Rights

Name Purpose Default Value Valid Valuesa Xilinx Valid Values

error_handling

What is the tool allowed to 
show in Error messages?

“delegated” “delegated”

“srcrefs”

“plaintext”

“delegated”b

runtime_visibility

What is tool allowed to 
show during display, tcl, or 
output reports?

“delegated” “delegated”

“interface_names”

“all_names”

“delegated”

child_visibility

If a protected module 
instantiates an 
unprotected child, how 
should error_handling and 
runtime_visibility be 
handled on that child? 
Note: Displayed messages 
could expose path-names 
through protected regions. 

“delegated” “delegated”

“allowed”

“denied”

“delegated”

“allowed”

decryption

Is the tool even allowed to 
decrypt the module? This 
it will often be used in 
conditional rights.

“delegated” “delegated”

“true”

“false”

“delegated”

“true”

“false“
Note: “delegated” = 
“true”

a. Valid values are case sensitive, and must be specified as shown. 
b. The behavior of Vivado tools can vary for delegated access rights. See Table 6-5 for more information. 
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Xilinx Tool Rights

Xilinx has created five specific tool rights that control Vivado tool behavior, as listed in the 
following table.

Key Definition and Rights Digest Method
The encryption key and rights digest method must be defined as part of a vendor specific 
toolblock. These are a set of mandatory pragmas which define the vendor public 
encryption key, key related attributes, and method for calculating the digest for rights in 
the toolblock of each vendor. The following example shows these pragmas and their 
valid values for Xilinx. 

`protect key_keyowner = “Xilinx”
`protect key_method = “rsa”
`protect key_keyname = “xilinx_2016_05”
`protect rights_digest_method = “sha256”
`protect key_public_key
...

Table 6-2: Xilinx Specific Tool Rights

Xilinx Right Name Meaning Xilinx Valid 
Values Default Values

xilinx_configuration_visible Are the LUT values allowed to be visible in 
viewers, editors, and so forth, in Vivado?

“true”, “false” “false”

xilinx_enable_modification Can netlist information within the protected 
region (hierarchy, connections, LUTs, and so 
forth) be modified using the Vivado tool?

“true”, “false” “false”

xilinx_enable_probing Is the customer allowed to insert or 
instantiate Vivado debug probes in the 
protected region? 

“true”, “false” “false”

xilinx_enable_netlist_export Is Vivado allowed to export a netlist of 
protected region? 

“true”, “false” “true”

xilinx_enable_bitstream Is the Vivado tool allowed to write out a 
bitsream? 

“true”, “false” “true”
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Rights Definition
The basic syntax for expressing an access right uses the control keyword introduced for 
IEEE-1735-2014 V2. 

Generally, the pragma looks as follows: 

`protect control <right> = <rights_expression>

Where: 

° control is the keyword identifying an access right.

° <right> is the access right being defined. 

° <rights_expression> is a statement of the availability of the right. 

IMPORTANT: Valid values for the rights_expression are case sensitive.

For example:

`protect control xilinx_configuration_visible = “false” 

Conditional Rights Definition
Conditional rights let IP authors specify different access rights under different evaluated 
conditions. The basic syntax for defining a conditional access right is: 

`protect control <right> = <condition> ? <true_expression> : <false_expression>

Where: 

° control is the keyword identifying an access right.

° <right> is the access right being defined. 

° <condition> is a condition test for the specified access right. 

° <true_expression> is the rights expression applied when the <condition> is 
true. 

° <false_expression> is the rights expression applied when the <condition> is 
false. 

° When <condition> evaluates as true, the right takes the value of 
<true_expression>, else right gets the value of <false_expression>. 

For example:

`protect control decryption = (xilinx_activity==simulation) ? "false" : "true"
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Chapter 6: Encrypting IP in Vivado
The results of the conditional expression defined above, when the activity is simulation, are 
detailed in the following table.

Conditional Rights Qualifiers

The IEEE 1735-2014 V2 standard defines activity as a conditional keyword. However, 
Xilinx does not support this keyword, and instead uses xilinx_activity as a conditional 
keyword. 

IMPORTANT: Other conditional keywords defined by IEEE 1735-2014 standard are not supported by 
Xilinx.

The xilinx_activity keyword breaks down the tool flow into abstract activities that 
align with the specific activities supported by the Vivado Design Suite. 

The following table lists the supported values for the xilinx_activity keyword.

Valid Rights Specification for Xilinx

The following is a partial VHDL encryption sample that shows a valid specification of the 
error_handling right. 

Although the commonblock specifies a value of “srcrefs”, which Xilinx does not 
support; that value is overridden in the Xilinx-specific toolblock. 

Table 6-3: Conditional Expression Evaluated

xilinx_activity Condition
(xilinx_activity==simulation)

?: 
Expression Result Comment

simulation true “false” Source data is not decrypted.

synthesis false “true” Source data is decrypted.

implementation false “true” Source data is decrypted.

Table 6-4: xilinx_activity Condition Keywords

Value Definition

simulation
The abstract activity that applies to tools that provide execution 
semantics. For Vivado simulator, this would refer to simulation at any 
stage of the tool chain. 

synthesis
The abstract activity that applies to tools that transform the IP into 
another symbolic form. In the Vivado tool flow, this equates to Vivado 
synthesis.

implementation
The abstract activity that applies to tools that does place and route of 
the netlist on FPGA device resources. In Vivado, this equals Vivado 
Implementation phase.
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Chapter 6: Encrypting IP in Vivado
In the following example, the IP author has defined the error_handling right as 
“delegated”, which Xilinx does support. 

`protect begin_commonblock
`protect control error_handling = “srcrefs”
`protect end_commonblock
`protect begin_toolblock
`protect key_keyowner=”Xilinx”,...
`protect control error_handling = “delegated”

Invalid Rights Specification for Xilinx

In the following invalid example, error_handling specifies a value of “srcrefs” in the 
commonblock, which Xilinx does not support. The Xilinx toolblock contains a conditional 
statement to override the error_handling right; however, when the xilinx_activity 
condition evaluates to TRUE, the unsupported value “srcrefs” is assigned to the right. 

In the following example, the Vivado tool issues an error and stops when attempting to 
decrypt this block. 

`protect begin commonblock 
`protect control error_handling = “srcrefs” 
`protect end_commonblock 
`protect begin_toolblock 
`protect key_keyowner=”Xilinx”, ... 
`protect control error_handling = (xilinx_activity==synthesis)? “srcrefs” : 
“delegated”

Encryption Payload
This is the IP RTL source code which needs to be protected. The beginning and end of the 
source code to be encrypted is defined using the following pragmas: 

`protect begin
...
`protect end

TIP: Remember that a module or entity/architecture pair definition is the smallest object within the 
RTL code that can be specified within the encryption payload. 
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Understanding How Rights Affect Vivado Tools
Following table shows how different rights affect the various Vivado tools. It includes both 
common rights and Xilinx-specific rights.

Table 6-5: How Rights Affect Vivado Tool Activities

Right/
Type Simulation Synthesis

Vivado Synthesis
Implementation

Vivado Implementation/ 
Timing/Viewers

error_handling/
common

• delegated = Hide error 
message references 
inside encrypted areas.

• delegated = Hide error 
message references 
inside encrypted areas.

• Not Applicable (NA)a

runtime_visibility/
common

• delegated = Follow 
current Vivado 
simulator behavior- 
hiding visibility in 
hierarchy viewer, and so 
forth.

• delegated = Follow 
current Vivado default 
behavior- hiding 
visibility.

• delegated = All 
names/hierarchy visible

child_visibility/
common

• delegated = No change 
to current Vivado 
simulator behavior 
(equivalent to Denied - 
hidden) 

• allowed = Show 
hierarchy, error 
messages for child 
levels.

• delegated = No change 
to current behavior 
(equivalent to Denied - 
hidden)

• allowed = Show 
names/message for 
child levels.

• delegated = allowed = 
No change to current 
behavior of Vivado 
implementation. 

decryption/
common

• delegated/true = Read 
in decrypted file.

• false = Do not read in 
decrypted file - issue 
message and stop 
processing.

• delegated/true = Read 
in decrypted file. 

• false = Do not read in 
decrypted file - issue 
message and stop 
processing.

• delegated/true = Read 
in decrypted file 

• false = Do not read in 
decrypted file - issue 
message and stop 
processing

xilinx_enable_netlist_export/
xilinx-specific

• NA • true = write_vhdl and 
write_verilog output 
netlists

• false = write_vhdl and 
write_verilog do not run

• true = write_vhdl and 
write_verilog output 
netlists

• false = write_vhdl and 
write_verilog do not run

xilinx_configuration_visible/
xilinx-specific

• NA • true = LUT contents 
visible.

• false = LUT contents 
NOT visible. 

• true = LUT contents 
visible.

• false = LUT contents 
NOT visible. 
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RTL Encryption Examples

VHDL Syntax
The following VHDL example features a common block that delegates error handling, and 
prohibits decryption during simulation using the IEEE defined activity condition, for 
which Xilinx uses xilinx_activity. 

Then, a Xilinx tool-specific block hides the configuration, prevents modification, and 
prevents probing of the encrypted logic. These are the three most-recommended 
Xilinx-specific rights. The tool-specific block also overrides the common block, granting the 
decryption right during simulation with the xilinx_activity condition. 

`protect version = 2
`protect encrypt_agent = “XILINX”
`protect encrypt_agent_info = “Xilinx Encryption Tool 2015"
`protect begin_commonblock
`protect control error_handling = “delegated”
`protect control decryption = (activity==simulation)? “false” : “true”
`protect end_commonblock
`protect begin_toolblock
`protect rights_digest_method=”sha256”
`protect key_keyowner = “Xilinx”, key_method = “rsa”, key_keyname = 
“xilinx_2016_05”, key_keyowner
...

xilinx_enable_modification/
xilinx-specific

• NA • true = Netlist 
modifications are 
allowed

• false = Netlist 
modifications are 
allowed

• true = Netlist 
modifications are 
allowed

• false = Netlist 
modifications are 
allowed

xilinx_enable_probing/
xilinx-specific

• NA • true = Allow customer 
to insert Analyzer 
probes into encrypted 
module/entity.

• false = Analyzer probes 
may not be inserted.

• true = Analyzer probes 
may be inserted into 
encrypted 
module/entity.

• false = Analyzer probes 
may not be inserted.

xilinx_enable_bitstream/
xilinx-specific

• NA • NA • true = Grant right to 
generate bitstream.

• false = Do not generate 
bitstream.

a. NA = Has no affect on the Vivado tool. 

Table 6-5: How Rights Affect Vivado Tool Activities (Cont’d)

Right/
Type Simulation Synthesis

Vivado Synthesis
Implementation

Vivado Implementation/ 
Timing/Viewers
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`protect control xilinx_configuration_visible = “false”
`protect control xilinx_enable_modification = “false”
`protect control xilinx_enable_probing = “false”
`protect control decryption = (xilinx_activity==simulation)? “false” : “true”
`protect end_toolblock = “”
`protect begin
-- Secure Data Block
-- Protected IP source code is inserted here. 
...
...
...
`protect end

Verilog Syntax
TIP: In Verilog and SystemVerilog, the `pragma protect keyword replaces the `protect keyword 
in VHDL. 

The following example is a Verilog version of the preceding VHDL example:

`pragma protect version = 2
`pragma protect encrypt_agent = “XILINX”
`pragma protect encrypt_agent_info = “Xilinx Encryption Tool 2015"
`pragma protect begin_commonblock
`pragma protect control error_handling = “delegated”
`pragma protect control decryption = (activity==simulation)? “false” : “true”
`pragma protect end_commonblock
`pragma protect begin_toolblock
`pragma protect rights_digest_method=”sha256”
`pragma protect key_keyowner = “Xilinx”, key_method = “rsa”, key_keyname = 
“xilinx_2016_05”, key_public_key
...
`pragma protect control xilinx_configuration_visible = “false”
`pragma protect control xilinx_enable_modification = “false”
`pragma protect control xilinx_enable_probing = “false”
`pragma protect control decryption = (xilinx_activity==simulation)? “false” : “true”
`pragma protect end_toolblock = “”
`pragma protect begin
// Secure Data Block
// Protected IP source code is inserted here. 
...
...
...

`pragma protect end
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Encrypting IP with Vivado 
The Vivado Design Suite provides a Tcl command, encrypt, that performs encryption on 
IEEE-1735-2014 V2 valid Verilog, SystemVerilog, and VHDL source files. 

See this link to the Vivado Design Suite Tcl Command Reference Guide (UG835) [Ref 11] for 
details. 

The encrypt command can also be used on the Verilog or VHDL output from any stage of 
the Vivado tool flow. The RTL source code can be encrypted, and then any files output by 
the write_verilog or write_vhdl commands later in the tool flow also have the 
protected IP automatically encrypted. 

Syntax:

encrypt [-key <arg>] -lang <arg> [-quiet] [-verbose] [-ext <arg>] <files>...

The encrypt Tcl command is available from the Tcl Console in the Vivado IDE, or in the 
standalone Vivado Tcl shell. By default, this command encrypts the existing files in-place, 
which means that the original files are overwritten and replaced with the encrypted 
versions unless you use the -ext option. 

IMPORTANT: Either use the -ext option to prevent encrypt from overwriting, or make copies of your 
source file prior to running the encrypt command. 

The IEEE-1735-2014 V2 definition area can be placed either in-line in the HDL source file, or 
in a separate key file. The encrypt -key option directs the Vivado tool where to look for 
this information. 

• The -key option specifies an RSA key file that includes the IEEE-1735-2014 V2 
supported pragmas that provide the encryption key, define access rights, and other 
optional information. The key file must use the same language and extension as the 
source files being encrypted (VHDL, Verilog, SystemVerilog). 

TIP: If -key is specified and the source file already has the encryption key and required pragmas in the 
definition area, the -key argument will be ignored. 

If -key is not specified, the Vivado tool looks for encryption keys and pragmas 
embedded within the source files that is being encrypted. 

The following example uses the -key option to do the following:

° Point to an encryption key file.

° Specify the target language as Verilog.
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° Specify the design file to encrypt.

° Specify a new file extension to use when generating the encrypted files to prevent 
overwriting the original source files.

encrypt -lang verilog -ext .vp -key keyfile.txt myip.v

The final example searches for the encryption key inside the design source file, specifies 
the target language as Verilog, specifies the design file to encrypt, and specifies a new file 
extension to use when generating the encrypted files to prevent overwriting the original 
source files:

encrypt -lang verilog -ext .vp my_ip.v

Xilinx IEEE-1735-2014 Public Key
Xilinx public keys (VHDL and Verilog) can be found inside the Vivado Design Suite 
installation hierarchy at the following location:

<Install_Dir>/Vivado/<version>/data/pubkey/

Third-Party Public Keys
To encrypt IP such that it can be read by a IEEE-1735-2014 V2 compliant third-party tool, 
you must obtain the public encryption key directly from the third-party tool provider. The 
third-party key definition must be in the pre-defined format, and can be placed into the key 
file next to the Xilinx key. During encryption, the Vivado tools use both public keys. 

IMPORTANT: Consult with third-party tool vendors to determine if they support V2 compliance level. 
Vendors who only support IEEE-1735-2014 version 1 are not compatible with V2 rights. 

Best Practices
• Keep encryption keys and pragmas in a key file and point to it using encrypt -key option.

• Use the encrypt -ext option to avoid inadvertently overwriting input files.

• Obtain public keys from tool vendors. 

CAUTION! Beware cutting and pasting from PDF and Word documents as these operations often 
corrupt the key; corruption is usually not apparent until the file is subsequently decrypted resulting in 
syntax errors.

• Use the same key file for as much IP as possible, which allows greater optimization of 
the resulting netlist.

• Encrypt all the files of an IP in a single call to encrypt.
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Chapter 6: Encrypting IP in Vivado
• Do not split a Verilog module between multiple encryption blocks and/or plain text 
sections.

• In VHDL, put the entire entity and architecture pair in a single encryption block.

• Verify that the encrypted code loads correctly into Vivado and a subsequent 
write_verilog re-encrypts all the secure design elements. 

• Verify interoperability with third-party tools.

Known Limitations
• The schematic view displays the structure of the encrypted blocks, and it is possible to 

browse the hierarchy of the secured netlist with the schematic viewer or using Tcl 
commands in the Tcl Console. 

• Encryption does not prevent connectivity tracing within Vivado. If net-names/structure 
is an important part of the IP, then use net-name obfuscation as a way to make name 
tracing harder. 

Note: Xilinx does not provide an obfuscater. 
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Appendix A

Standard and Advanced File Groups

Introduction 
This appendix lists the Standard and Advanced file group categories and descriptions.

IMPORTANT: NGC format files are not supported in the Vivado Design Suite for UltraScale® devices. It 
is recommended that you regenerate the IP using the Vivado Design Suite IP customization tools with 
native output products. Alternatively, you can use the NGC2EDIF command to migrate the NGC file to 
EDIF format for importing. However, Xilinx recommends using native Vivado IP rather than 
XST-generated NGC format files going forward

Standard File Groups
The following table lists the Standard file group types and a description.

Table A-1: Standard File Group Types and Descriptions 

Standard File Groups

Examples Files that make up an example. Typically contains a constraint (XDC), HDL, and/or XIT files. 
Vivado uses these files to seed a new Vivado example project and shows this to the 
end-user for their exploration. The files are available for both synthesis and simulation.

Product 
Guide

The production guide for an IP.

Readme Any required readme.txt file. 

Simulation Simulation files to deliver. Use when you have a mix of VHDL and Verilog to simulate 
together. Typically, exclusive of “VHDL Simulation” and “Verilog Simulation.” The files 
could be the same as the files in the corresponding synthesis file group (when the 
synthesis files can also be used for simulation) or could be different (when a behavioral 
simulation model files are to be used).

Synthesis Synthesis files to deliver. Use when you have a mix of VHDL and Verilog to synthesize to 
together. Typically exclusive of “VHDL Simulation” and “Verilog Simulation.” Adding a 
constraint (XDC) file here causes the constraint file to be applied to the top-level of the 
IP during implementation.
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Advanced File Groups
The following table contains a listing and a description of each Advanced file group type.

Verilog 
Simulation

Simulation files to deliver. Use when you have a Verilog only representation to simulate. 
You might see both this file group and “VHDL Simulation” to allow the ability to have a 
language-specific IP simulation. The files could be the same as the files in the 
corresponding synthesis file group (when the synthesis files can also be used for 
simulation) or might be completely different (when a behavioral simulation model files 
are to be used).

Verilog 
Synthesis

Synthesis files to deliver. Use when you have a Verilog-only representation to synthesize. 
You might see both this file group and “VHDL Synthesis” to allow the ability to have a 
language specific implementation of the IP. Adding a constraint (XDC) file here applies 
the constraint file to the top-level of the IP during implementation.

Note: Synthesis run files are not stored in the IP packager.

VHDL 
Simulation

Simulation files to deliver. Use when you have a VHDL only representation to simulate. 
You might see both this file group and “Verilog Simulation” to allow the ability to have a 
language specific IP simulation. The files could be the same as the files in the 
corresponding synthesis file group (when the synthesis files can also be used for 
simulation) or might be completely different (when a behavioral simulation model files 
are to be used).

VHDL 
Synthesis

Synthesis files to deliver. Use when you have a VHDL only representation to synthesize. 
You might see both this file group and “Verilog Synthesis” to allow the ability to have a 
language specific implementation of the IP. Adding a constraint (XDC) file here causes the 
constraint file to be applied to the top-level of the IP during implementation.

Table A-1: Standard File Group Types and Descriptions  (Cont’d)

Standard File Groups

Table A-2: Advanced File Group Types and Descriptions

Advanced File Groups

Catalog Disabled Icon GUI icon to show in the IP catalog when the IP is disabled (for example, when 
the IP does not support the selected device family). Supported file types are GIF, 
JPEG, and PNG.

Catalog Icon GUI icon to show in the IP catalog. Supported file types are GIF, JPEG, and PNG.

C Simulation Use to deliver files for c-model simulation. These files are copied out without 
any further processing (excepting Tcl and XIT which is always evaluated). If you 
are delivering pre-compiled libraries, it is suggested to deliver these in machine 
specific directories following the Vivado convention (for example; lnx32, lnx64, 
win32, and win64).

Custom UI Layout Tcl file to control custom GUI layout and customization. Only a single file is 
allowed, additional files should be added to the Utility XIT file group.

Data sheet IP Data sheet. 

Encrypted Data sheet Encrypted IP Data sheet. 
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Example Implementation Files to apply for implantation, post synthesis in an example design. Typically 
only XDC files should be added.

Examples Script Script to create example project. Typically only Tcl files should be added.

Examples Script Extension Script to extend our default example project script. Typically only Tcl files should 
be added.

Examples Simulation Files that make up a simulation example design. Typically exclusive of the 
“Examples” and “Example Synthesis” file groups.

Getting Started Guide Getting Started Guide. 

Implementation Files that make up an implementation design. Typically this file group contains 
only implementation (XDC) constraints.

MATLAB Simulation MATLAB® software simulation file.

MIF Files MIF file.

Miscellaneous Vivado copies any files in the group to disk during generation. It is 
recommended that you use another, appropriate file group.

Reference Design Files that make up a reference design.

Software Drivers Any created software drivers.

System C Simulation  Use to deliver files for System-C Simulation. If you are delivering pre-compiled 
libraries, it is suggested to deliver these in machine-specific directories 
following the Vivado convention (such as lnx32, lnx64, win32, and win64).

System Generator Simulation Any System Generator simulation.

System Verilog Simulation Use to deliver files for System-Verilog simulation.

Test Bench One or more test bench files written in both VHDL and Verilog. Add all mixed 
language test bench files for delivery to the end-user, even if there are multiple 
top modules.

UI DRCs User Interface Design Rule Checks.

UI Icon GUI icon to use in IP Customization GUI. Supported file types are GIF, JPEG, and 
PNG.

UI Layout Tcl file to control GUI layout and customization. Only a single file is allowed, 
additional files should be added to the Utility XIT file group.

Upgrade Tcl Functions  Xilinx scripts supporting upgrades from previous versions of IP. These allow the 
later version of provide an equivalent instance to the earlier version of IP.

Utility XIT/TTCL Add any utility files used during TTCL, XIT, or XSpice generation. These can 
either be data files, include files or extra evaluation Tcl files. For XSpice, only a 
single Tcl file is allowed in its file group, therefore any add any additional 
supporting Tcl files here.

Verilog Instantiation Template Verilog instantiation template.

Verilog Test Bench Test bench files written in Verilog.

Version Information Version information. 

VHDL Instantiation Template VHDL instantiation template. 

VHDL Test Bench  Test Bench files written in VHDL.

Table A-2: Advanced File Group Types and Descriptions (Cont’d)

Advanced File Groups
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Appendix B

Additional Resources and Legal Notices

Xilinx Resources
Support resources such as Answers, Documentation, Downloads, and Forums, see Xilinx 
Support.

Solution Centers
See the Xilinx Solution Centers for support on devices, software tools, and intellectual 
property at all stages of the design cycle. Topics include design assistance, advisories, and 
troubleshooting tips. 

Documentation Navigator and Design Hubs
Xilinx Documentation Navigator provides access to Xilinx documents, videos, and support 
resources, which you can filter and search to find information. To open the Xilinx 
Documentation Navigator (DocNav):

• From the Vivado IDE, select Help > Documentation and Tutorials.

• On Windows, select Start > All Programs > Xilinx Design Tools > DocNav.

• At the Linux command prompt, enter docnav.

Xilinx Design Hubs provide links to documentation organized by design tasks and other 
topics, which you can use to learn key concepts and address frequently asked questions. To 
access the Design Hubs:

• In the Xilinx Documentation Navigator, click the Design Hubs View tab.

• On the Xilinx website, see the Design Hubs page.

Note: For more information on Documentation Navigator, see the Documentation Navigator page 
on the Xilinx website.
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References

Xilinx Web Sites
1. Vivado IP Versioning 

2. Vivado Answer Record: 68071

Vivado Design Suite Documentation
The following documents are either cited within this guide or are helpful resources:

3. Vivado Design Suite User Guide: Design Flows Overview (UG892)

4. Vivado Design Suite User Guide: Hierarchical Design (UG905)

5. Vivado Design Suite User Guide: Using Constraints (UG903) 

6. Vivado Design Suite User Guide: Logic Simulation (UG900)

7. Vivado Design Suite Tutorial: Designing with IP Tutorial (UG939)

8. Vivado Design Suite User Guide: Designing with IP (UG896)

9. Vivado Design Suite User Guide: System-Level Design Entry (UG895)

10. Vivado Design Suite User Guide: Release Notes, Installation, and Licensing (UG973)

11. Vivado Design Suite Tcl Command Reference Guide (UG835)

12. Vivado Design Suite User Guide: Programming and Debugging (UG908)

13. Vivado Design Suite Tutorial: Logic Simulation (UG937)

14. Vivado Design Suite Tutorial: Design Flows Overview (UG888) 

15. Vivado Design Suite User Guide: Using Tcl Scripting (UG894)

16. Vivado Design Suite User Guide: Using the Vivado IDE (UG893)

17. Vivado Design Suite User Guide: Designing IP Subsystems Using IP Integrator (UG994)

18. Vivado AXI Reference Guide (UG1037) 

19. Vivado Design Suite Properties Reference Guide (UG912)

20. Vivado Design Suite Tutorial: Programming and Debugging (UG936) 

21. Vivado Design Suite Tutorial: Creating and Packaging Custom IP (UG1119)

22. Vivado Design Suite User Guide: Synthesis (UG901)

23. UltraFast Design Methodology Guide for the Vivado Design Suite (UG949)

24. UltraScale Architecture Libraries Guide (UG974) 
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25. Vivado Design Suite User Guide: Implementation (UG904)

26. Vivado Design Suite Documentation 

 Xilinx IP Documentation
27. Integrated Logic Analyzer LogiCore Product Guide (PG172) 

28. IBERT for 7 Series GTX Transceivers LogicCORE Product Guide (PG132) 

29. IBERT for 7 Series GTP Transceivers LogiCore Product Guide (PG133)

30. IBERT for 7 Series GTH Transceivers LogiCore Product Guide (PG152) 

31. Virtual Input/Output LogiCore Product Guide (PG159)

Third-Party Documentation
32. Recommended Practice for Encryption and Management of Electronic Design Intellectual 

Property (IP) (IEEE-1735-2014)

Xilinx QuickTake Videos
• Vivado Design Suite QuickTake Video: Creating an AXI Peripheral in Vivado 

• Vivado Design Suite QuickTake Video: Packaging Custom IP Integrator 

• Vivado Design Suite QuickTake Video: Using Vivado Design Suite with Revision Control

• Vivado Design Suite QuickTake Video Tutorials 
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Appendix B: Additional Resources and Legal Notices
Please Read: Important Legal Notices
The information disclosed to you hereunder (the “Materials”) is provided solely for the selection and use of Xilinx products. To the 
maximum extent permitted by applicable law: (1) Materials are made available "AS IS" and with all faults, Xilinx hereby DISCLAIMS 
ALL WARRANTIES AND CONDITIONS, EXPRESS, IMPLIED, OR STATUTORY, INCLUDING BUT NOT LIMITED TO WARRANTIES OF 
MERCHANTABILITY, NON-INFRINGEMENT, OR FITNESS FOR ANY PARTICULAR PURPOSE; and (2) Xilinx shall not be liable (whether 
in contract or tort, including negligence, or under any other theory of liability) for any loss or damage of any kind or nature related 
to, arising under, or in connection with, the Materials (including your use of the Materials), including for any direct, indirect, special, 
incidental, or consequential loss or damage (including loss of data, profits, goodwill, or any type of loss or damage suffered as a 
result of any action brought by a third-party) even if such damage or loss was reasonably foreseeable or Xilinx had been advised 
of the possibility of the same. Xilinx assumes no obligation to correct any errors contained in the Materials or to notify you of 
updates to the Materials or to product specifications. You may not reproduce, modify, distribute, or publicly display the Materials 
without prior written consent. Certain products are subject to the terms and conditions of Xilinx’s limited warranty, please refer to 
Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos; IP cores may be subject to warranty and 
support terms contained in a license issued to you by Xilinx. Xilinx products are not designed or intended to be fail-safe or for use 
in any application requiring fail-safe performance; you assume sole risk and liability for use of Xilinx products in such critical 
applications, please refer to Xilinx’s Terms of Sale which can be viewed at https://www.xilinx.com/legal.htm#tos.
AUTOMOTIVE APPLICATIONS DISCLAIMER
AUTOMOTIVE PRODUCTS (IDENTIFIED AS “XA” IN THE PART NUMBER) ARE NOT WARRANTED FOR USE IN THE DEPLOYMENT OF 
AIRBAGS OR FOR USE IN APPLICATIONS THAT AFFECT CONTROL OF A VEHICLE (“SAFETY APPLICATION”) UNLESS THERE IS A 
SAFETY CONCEPT OR REDUNDANCY FEATURE CONSISTENT WITH THE ISO 26262 AUTOMOTIVE SAFETY STANDARD (“SAFETY 
DESIGN”). CUSTOMER SHALL, PRIOR TO USING OR DISTRIBUTING ANY SYSTEMS THAT INCORPORATE PRODUCTS, THOROUGHLY 
TEST SUCH SYSTEMS FOR SAFETY PURPOSES. USE OF PRODUCTS IN A SAFETY APPLICATION WITHOUT A SAFETY DESIGN IS FULLY 
AT THE RISK OF CUSTOMER, SUBJECT ONLY TO APPLICABLE LAWS AND REGULATIONS GOVERNING LIMITATIONS ON PRODUCT 
LIABILITY.
AMBA, AMBA Designer, ARM, ARM1176JZ-S, CoreSight, Cortex, PrimeCell, and MPCore are trademarks of ARM in the EU and other 
countries. 
© Copyright 2012-2017, Xilinx, Inc. Xilinx, the Xilinx logo, Artix, ISE, Kintex, Spartan, Virtex, Vivado, Zynq, and other designated 
brands included herein are trademarks of Xilinx in the United States and other countries. All other trademarks are the property of 
their respective owners. 
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